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Chapter 1: Introduction

Pro Tools® | HD I/O by Avid®is a multi-channel
digital audio interface designed for use with

Pro Tools® | HDX, Pro Tools® | HD Native, and
Pro Tools® | HD systems. HD 1/O features 24-bit
analog-to-digital (A/D) and digital-to-analog
(D/A) converters, and supports sample rates of up
to 192 kHz.

HD I/O comes in three standard configurations:

* 8x8x 8 (8analogin, 8 analog out, and 8 dig-
ital in and out)

* 16 x 16 analog in and out

* 16 x 16 digital in and out

You can also add or remove analog (ADC and
DAC) and digital cards for custom configurations.

Pro Tools | HD 1/0O Features

HD 1/0 provides up to sixteen discrete channels of
audio input and output, each with a four-segment
LED meter. The total available analog and digital
/O is dependent on the configuration of Analog
and Digital Expansion I/O cards installed in

HD 1/0.

Analog I/O

» Up to 16 channels of 24-bit D/A and A/D con-
verters for superior analog input and output at
sample rates of 44.1 kHz, 48 kHz, 88.2 kHz,
96 kHz, 176.4 kHz, and 192 kHz with Analog In
and Analog Out HD I/O cards

* Soft Clip and Curv limiting circuits to protect
against clipping on analog input

Digital I/O

» Up to 16 channels of 24-bit digital I/O, using
AES/EBU, TDIF DB-25, or Optical at sample
rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz,
176.4 kHz, and 192 kHz with a Digital HD I/O
card

» Real-time sample rate conversion on digital in-
puts with a Digital I/O card (up to sixteen chan-
nels of AES/EBU, Optical, or TDIF)

* Support for S/MUX Optical for sample rates of
88.2 kHz and higher

 Support for 2 channels of S/PDIF Optical
(enclosed) with sample rates of up to 96 kHz

2 channels of AES/EBU I/O (enclosed) with
support for sample rates up to 192 kHz

* 2 channels of 24-bit-capable S/PDIF I/O
(enclosed) with support for sample rates up to
192 kHz
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Synchronization

* Loop Sync input and output for connecting addi-
tional Avid HD audio interfaces and peripherals

 External Clock input and output for synchroniz-
ing HD /0 with external Word Clock devices

Expandability
* Optional addition of I/O cards to expand analog
or digital I/O

 Simultaneous use of multiple Avid HD audio in-
terfaces to further expand system input and out-
put

What’s Included
* Pro Tools | HD I/O audio interface
* AC power cable
» DigiLink Mini cable (18 inches [0.46m])
» DigiLink Mini adapter
* BNC cable (18 inches [0.46m])
* Pro Tools | HD I/O Guide
* Health and Safety Guide

» Registration Information Card

2 Pro Tools | HD I/O Guide

System Requirements and
Compatibility

Avid can only assure compatibility and provide
support for hardware and software it has tested and
approved.

For complete system requirements and a list of
qualified computers, operating systems, hard
drives, and third-party devices, visit:

www.avid.com/compatibility

Registration

Review the enclosed Registration Information
Card and follow the instructions on it to quickly
register your purchase online. By registering, you
become eligible to receive the following:

 Technical support information
» Software update and upgrade notices

* Hardware warranty information

Hardware Warranty

Your warranty can be found on the Registration
Information Card.



About This Guide

This guide provides a basic overview of
Pro Tools | HD 1/O features and functionality.

For hardware installation instructions for your
Pro Tools | HDX hardware, see the
Pro Tools | HDX Card Installation Guide.

For hardware installation instructions for your
Pro Tools | HD Native hardware, see the
Pro Tools | HD Native Installation Guide.

For hardware installation instructions for your
Pro Tools|HD hardware, see the Pro Tools|HD
User Guide.

For Pro Tools software installation instructions,
see the Pro Tools | Sofiware Installation Guide.

For additional information about using Pro Tools
software, see the Pro Tools Reference Guide (in
Pro Tools, choose Help > Pro Tools Reference
Guide).

Conventions Used in This Guide

All of our guides use the following conventions to
indicate menu choices and key commands:

Convention Action

File > Save Choose Save from the
File menu

Control+N Hold down the Control key
and press the N key

Control-click Hold down the Control key
and click the mouse button

Right-click Click with the right
mouse button

The names of Commands, Options, and Settings
that appear on-screen are in a different font.

The following symbols are used to highlight
important information:

Q User Tips are helpful hints for getting the

most from your system.

A\ Important Notices include information that
could affect your data or the performance of
your system.

Shortcuts show you useful keyboard or mouse
shortcuts.

Cross References point to related sections in
this guide and other Pro Tools guides.
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About www.avid.com

The Avid website (www.avid.com) is your best
online source for information to help you get the
most out of your Pro Tools system. The following
are just a few of the services and features available.

Product Registration Register your purchase
online.

Support and Downloads Contact Avid Customer
Success (technical support); download software
updates and the latest online manuals; browse the
Compatibility documents for system requirements;
search the online Knowledge Base or join the
worldwide Pro Tools community on the User
Conference.

Training and Education Study on your own using
courses available online or find out how you can
learn in a classroom setting at a certified Pro Tools
training center.

Products and Developers Learn about Avid prod-
ucts; download demo software or learn about our
Development Partners and their plug-ins, applica-
tions, and hardware.

News and Events Get the latest news from Avid or
sign up for a Pro Tools demo.
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Chapter 2: Pro Tools | HD 1/0 Overview

This chapter describes the front and back panel features of the Pro Tools | HD 1/0.

Pro Tools | HD 1/O Front Panel

HD I/O Front Panel

Power Switch and LED Ring

This button turns HD 1/O on and off. The LED ring
around the power button will light green or orange
to indicate the system status:

Green LED Ring Indicates that the unit has pow-
ered up successfully and is connected to an active
system.

Orange LED Ring Indicates that the unit has
power, but the computer it is connected to is shut
down.

Sample Rate

These LEDs display the current sample rate of the
HD I/0 internal clock: 44.1 kHz, 48 kHz,

88.2 kHz, 96 kHz, 176.4 kHz, or 192 kHz. The
sample rate can be set in Pro Tools when you cre-
ate a new session, or in the Hardware Setup or
Playback Engine dialogs if no session is open.
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Loop Master LED

The LOOP MASTER LED indicates which audio
interface is the master peripheral. The Loop Mas-
ter LED will be continuously lit on the current
Loop Master peripheral only, and unlit on all other
peripherals. (Only one Avid HD peripheral can be
Loop Master at a time.) The Loop Master LED will
always be lit with a single interface.

With HDX hardware, Loop Master defaults to the
first audio interface connected to DigiLink Mini
Port 1 on the first card in the system.

With HD Native hardware, Loop Master defaults
to the first audio interface connected to DigiLink
Mini Port 1 on the HD Native card.

For Pro Tools|HD systems, Loop Master defaults
to the first audio interface connected to the pri-
mary, or “core” Pro Tools/HD card. On

Pro Tools|HD (for PCle), this is the Accel Core
card. On Pro Tools[HD (for PCI), this is the HD
Core card.

Sync Mode LEDs

The SYNC MODE LEDs indicate the current
Clock Source as set in Pro Tools.

INT (Internal) Indicates the HD I/O sample clock is
generated by its internal clock, as determined by
the session Sample Rate.

DIG (Digital) Indicates that an external AES/EBU,
TDIF, Optical (ADAT), Optical (ADAT S/MUX),
or S/PDIF device is providing system clock. If no
valid clock source is detected, HD 1I/O will switch
to internal clock, the DIG LED will flash, and an
error message will appear on-screen in Pro Tools.

LOOP Indicates that the HD 1/O is slaving to an-
other Avid HD audio interface or SYNC peripheral
using Loop Sync.
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EXT (External) Indicates that the HD I/O is using
the EXT CLOCK IN port for system synchroniza-

tion.

When synchronized to Word Clock, External
Clock input and output do not have to be at the

Word Clock rate. EXT CLOCK IN synchroniza-
tion will typically be 1x the current session sample

rate. However, for sample rates higher than 48

kHz, HD I/O generates a choice of 1x, 2x, or 4x of

a base rate of 44.1 kHz or 48 kHz, as

follows:
Session Sample Rate | Word Clock Support
441 kHz 441 kHz
48 kHz 48 kHz
88.2 kHz 88.2 kHz
44.1 kHz
96 kHz 96 kHz
48 kHz
176.4 kHz 176.4 kHz
441 kHz
192 kHz 192 kHz
48 kHz
Meters

These four-segment LEDs indicate signal level for
each of the sixteen channels. The top row of meters
indicates input levels, and the bottom row shows

output levels. These meters are calibrated at —42
dB, -18 dB, —6 dB, and 0 dB,

respectively.

Q Note that 0 dB is not to be confused with clip-
" ping; use the on-screen meters in Pro Tools

to determine whether a signal is clipping.




Pro Tools | HD 1/0 Back Panel

Bay 1: Analog In card Bay 3: Digital I/O card Enclosure

Bay 2: Analog Out card Bay 4: Empty for Optional card
HD I/0 Back Panel, 8 x 8 x 8 configuration shown

Although the HD I/O is a sixteen-channel audioin-  Input and Output Cards
terface, it has up to 94 inputs and outputs available
through its various back panel

connectors.

The HD I/O features four bays for HD I/O
Expansion cards. With the standard 8 x 8 x 8 con-
figuration, bays 1-3 contain Analog In, Analog
HD 1/0 comes in three standard configurations: Out, and Digital I/O cards, respectively. The fourth
bay (as shown in this 8 x 8 x 8 configuration) is an
expansion bay, for which you can purchase an ad-
ditional Expansion I/O card of your choice.

* 8 x 8 x 8 analog and digital in and out

* 16 x 16 analog in and out

* 16 x 16 digital in and out
By installing an optional AD Expansion card, DA
Expansion card, or Digital Expansion card, you
can add even more I/O capacity (up to a maximum
possible 110 inputs and outputs). See Chapter 5,
“Adding or Removing I/O Cards.”

A\ Tnput and Output cards for 192 1/0 are not
supported in HD I/0.
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Analog Input

The HD 1/O Analog In card contains connectors
for analog audio input with 24-bit, 192 kHz A/D
converters. Input is provided through two discrete
DB-25 connectors (one for +4 dBu sources, and
the other for —10 dBV sources). You can connect
sources at both operating levels and choose be-
tween them from within Pro Tools.

+4 dBu Balanced Provides eight balanced input
channels at +4 dBu nominal operating levels.

—10 dBV Balanced Provides eight balanced input
channels at —10 dBV nominal operating levels.

Q Most consumer electronics operate at —10 dBV
~levels, and may not feature balanced inputs and
outputs. You can connect —10 dBV signals to
the —10 dBV inputs, but you will need to make
sure that the negative terminals are not con-
nected.

For wiring information, see Chapter 6, “Pinout Di-
agrams for the DB-25 Connectors.”

For each channel, you can select input level from
within the Hardware Setup dialog (see “Hardware
Setup” on page 21).

Input Trims

The Input Trims below the DB-25 connectors are
used to individually calibrate each channel’s input
level. See “Input Trims” on page 30.

Additionally, the Limiter function helps avoid dig-
ital clipping (see“Limiter” on page 26).
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Analog Output

The HD I/O Analog Out card contains a single
DB-25 connector and Output Trims for eight
channels of analog audio output. These balanced
outputs operate at +4 dBu levels. See Chapter 6,
“Pinout Diagrams for the DB-25 Connectors.”

Q For—10 dBV gear, you can switch a jumper
"~ on Analog Output cards (on a channel-by-
channel basis) from the default Hi position
to Lo for a —6 dB pad. You can then adjust
the Trim pot for the corresponding output
channels by an additional —4 dB to accom-
modate —10 dBV gear. For more informa-
tion, see Chapter 7, “HD I/O Calibration
Mode Instructions.”

Output Trims

The Output Trims below the DB-25 connector are
used to individually calibrate each channel’s out-
put level. For more information, see Chapter 7,
“HD I/O Calibration Mode Instructions.”



Digital 1/0

The Digital I/O card contains connectors for eight
channels each of AES/EBU 1/O, TDIF 1/0O, and
Optical (ADAT) I/O. Only one digital format can
be used at a time.

AES/EBU DB-25 connectors for eight channels of
AES/EBU input and output. Each of the paired
channels is a balanced three-conductor signal, and
supports 192 kHz sample rates in single-wire
mode up to eight channels. Dual-wire mode uses
two HD I/O physical I/O channels of AES/EBU
1/O to carry each single stream of 176.4 kHz or
192 kHz audio. Therefore, only four simultaneous
channels of AES/EBU I/O are available at

176.4 kHz or 192 kHz.

TDIF DB-25 connectors for eight channels of
TDIF input and output. Conforms to standard
eight-channel TDIF pinouts. For more informa-
tion, see Chapter 6, “Pinout Diagrams for the DB-
25 Connectors.”

Q We recommend using Avid DB-25 TDIF
cables for optimum compatibility.

Optical (ADAT) Dedicated, eight-channel 24-bit
capable Optical ports (up to 48 kHz), with real-
time sample rate conversion on input (only). Note
that Optical S/PDIF is not supported with the Dig-
ital I/O card and is supported with the enclosed
Optical ports only (for more information, see “Op-
tical (ADAT) [Encl]” on page 10).

The inputs on the Digital I/O card feature real-time
sample rate conversion. For example, you can
stream audio with a sample rate of 44.1 kHz into a
96 kHz session.

For more information, see “Hardware Setup”
on page 21.

Enclosure Connectors

The right half of the back panel of HD I/O features
a set of non-removable connectors that are
mounted to the enclosure.

These connectors include two channels of
AES/EBU 10, Optical 1/0 (for another eight chan-
nels of ADAT format, or two channels of Optical
S/PDIF), and two channels of coaxial S/PDIF 1/0.
On-screen, these connectors are identified as
AES/EBU [Encl], Optical (ADAT) [Encl], Optical
(S/PDIF) [Encl], and S/PDIF [Encl].

Other connectors include Loop Sync, External
Clock, and ports for attaching the HD 1/0 to HDX,
HD Native, or Pro Tools|HD cards, or to other
Avid HD audio interfaces.
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AES/EBU [Encl]

These are balanced, three-conductor XLR connec-
tors that accept and output a stereo, 24-bit
AES/EBU audio signal. These two ports support
up to 192 kHz sample rates.

Optical (ADAT) [Encl]

These Optical ports provide up to eight channels of
Optical (ADAT) input and output, or two channels
(stereo) optical S/PDIF input and output. Optical

(ADAT) mode supports sample rates up to 48 kHz.
Using S/MUX, these Optical ports support provide
up to four channels of Optical S/MUX input and

output at sample rates of 88.2 and 96 kHz, and up
to two channels of Optical S/MUX input and out-
put at sample rates of 176.4 and 192 kHz. In TOS-
Link mode, the ports support two channels of Op-
tical input and output at sample rates up to 96 kHz.

Q Configure HD 1/0O for ADAT S/MUX on the
©enclosed ADAT port and also on the ADAT
port on the Digital /O card to get 8 channels
at 88.2/96 kHz or 4 channels at
176.4/192 kHz.

About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel
optical digital audio connection created by Alesis.
Lightpipe is found on many devices, including Op-
tical (ADAT) decks, modular digital multitracks
(MDMs), A/D or D/A converters, S/MUX, and
digital consoles.

S/PDIF Digital In and Out

These are unbalanced RCA jacks that receive and
send two channels of S/PDIF audio. S/PDIF sup-
ports up to 24-bit audio, at sample rates up to 192
kHz.

Q To maintain data integrity and minimize jit-
" ter, use only 75-ohm coaxial cable for
S/PDIF connections.
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DigiLink Mini Ports

EXPAHSION PORT

a__»

FRIMARY PORT

a_»

PRIMARY PORT

Use the PRIMARY PORT to connect HD I/O to

HDX or HD Native cards using a DigiLink Mini

cable, or to Pro Tools|HD cards using a DigiLink
cable with a DigiLink Mini adapter.

The Primary port sends and receives 32 channels to
and from an HDX, HD Native, or Pro Tools|HD
card. Input and output channels 17-32 (if active)
are passed through to the EXPANSION PORT.

EXPANSION PORT

The EXPANSION PORT lets you connect an ad-
ditional Avid HD audio interface to HD I/O. The
EXPANSION PORT passes input and output
channels 17-32 to the expansion (or secondary)
audio interface.

This port is only available when HD 1/O is con-
nected directly to an HDX, HD Native, or

Pro Tools|HD card. It is not available when the
HD 1/0O is connected to the Expansion Port on an-
other audio interface.



DigiLink Mini Cables and Adapters

Avid provides various cables and adapters to con-
nect Avid HD audio interfaces to HDX,
HD Native, and Pro Tools|HD cards.

% For more information about DigiLink Mini
cables and adapters, visit the Avid website
(www.avid.com).

DigiLink Mini Cables

Use a DigiLink Mini cable to connect an HD I/O to
an HDX or HD Native card, or to other Avid HD
audio interface (such as another HD I/O).

There are five different lengths of DigiLink Mini
cables:

* 18in (0.46m)
* 12 ft (3.6m) (sold separately)
e 25 ft (7.62m) (sold separately)

* 50 ft (15.25m), the maximum length sup-
ported for 176.4 kHz and 192 kHz sessions
(sold separately)

* 100 ft (30.5m), the maximum length sup-
ported by 88.2 kHz and 96 kHz sessions (sold
separately)

DigiLink Mini Adapters

Use a DigiLink cable with a DigiLink Mini adapter
to connect HD I/O to a Pro Tools|HD card. You
can also use a DigiLink Mini adapter to connect
HD 1/0O to legacy Pro Tools|HD audio interfaces
(such as 192 I/O).

There are two types of DigiLink Mini adapters:
* 12 in DigiLink Mini female to DigiLink male
* 12 in DigiLink Mini male to DigiLink female

Clock and Synchronization Ports

WD CLOCK IN and OUT

The Word Clock I/O ports are standard BNC con-
nectors that receive and output word clock signal.
These ports can be used to synchronize HD 1/0
with any word clock-capable device.

Word Clock In can be configured by selecting it as
the Clock Source in the Hardware Setup dialog in
Pro Tools. Word Clock Out can also be configured
in the Hardware Setup dialog using the External
Clock Output selector.

Q Because crucial timing data is passed
through the Loop Sync and Word Clock
ports, you should use high-quality, 75-Ohm
RG-59 cables for making connections.

Chapter 2: Pro Tools | HD I/O Overview
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LOOP SYNC In and Out

Loop Sync is a dedicated clock loop for synchro-
nizing multiple Pro Tools|HD peripherals together
(multiple audio interfaces, ora SYNC HD and one
or more audio interfaces). Loop Sync technology
lets you synchronize to any digital peripheral con-
nected to any of the Pro Tools|HD audio interfaces
in your Pro Tools system. Loop Sync uses a word
clock signal based on sample rates of either

44.1 kHz or 48 kHz. As sample rate increases in
the system, Loop Sync continues to operate at a
base rate of 44.1 kHz or 48 kHz, depending upon
the higher rate.

The Loop Sync In and Out ports are standard BNC
connectors that output a 1x Word clock signal.
Loop Sync should only be used to chain multiple
Pro Tools|HD peripherals together (such as

Pro Tools|HD audio interfaces and SYNC HD).

AC Power

This connector accepts a standard AC power cable.
HD I/O is auto power-selecting (100V to 240V)
and will automatically work with a standard mod-
ular cable (IEC) to connect to AC power outlets in
any country.

Accessory Port

This port currently has no functionality.

12 Pro Tools | HD I/O Guide



Chapter 3: Connecting Pro Tools | HD 1/0

Pro Tools | HD I/O provides up to sixteen channels
of analog and digital I/O with HD I/O with HDX,
HD Native, or Pro Tools|HD hardware.

HDX With Pro Tools | HDX hardware, HD 1/O is
connected to the HDX card using a DigiLink Mini
cable. You can connect additional HD audio inter-
faces to your system using the Expansion port on
the back of HD I/O, the second DigiLink Mini Port
on the HDX card, or by using additional HDX
cards. See “Connecting Pro Tools | HD I/O to

Pro Tools | HDX Cards” on page 14.

For more information about installing HDX
cards, see the Pro Tools | HDX Installation
Guide.

HD Native With Pro Tools | HD Native hardware,
HD 1/0 is connected to the HD Native card using a
DigiLink Mini cable. You can connect additional
HD audio interfaces to your system using the Ex-
pansion port on the back of HD I/O or the second
DigiLink Mini Port on the HD Native card. See
“Connecting Pro Tools | HD I/O to a

Pro Tools | HD Native Card” on page 16.

For more information about installing the HD
Native card, see the Pro Tools | HD Native
Installation Guide.

Pro Tools|HD With Pro Tools|HD hardware,

HD 1/0O is connected to a Pro Tools|HD card
using a DigiLink cable with a DigiLink Mini
adapter. You can connect additional HD audio in-
terfaces to your system using the Expansion port
on the back of HD I/O or using additional

Pro Tools|HD cards. See “Connecting

Pro Tools | HD 1/0O to Pro Tools|HD Cards” on
page 18.

For more information about installing
Pro Tools|HD cards, see the Pro Tools|HD
User Guide.

Rack Mounting HD Audio Interfaces

HD 1/O and all Avid HD audio interfaces need
room at their sides to maintain proper air flow for
cooling. Do not block the sides of the unit or dis-
connect the internal fan. If the units are rack-
mounted in a case, remove the case lids or doors
before operating the system. Failure to do so can
result in the units overheating very quickly, which
can permanently damage sensitive

components.

Chapter 3: Connecting Pro Tools | HD I/O
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Connecting Pro Tools | HD 1/0 to Pro Tools | HDX Cards

Each HDX card supports up to 64 channels of audio input and output. To get a full 64 channels of /O, you
can connect up to four 16-channel HD I/O to an HDX card. Two of the interfaces connect directly to Dig-
iLink Mini Ports 1 and 2, and the other two HD I/O connect to the Expansion ports on first two HD 1/O.

To connect HD 1/O to an HDX card:

= Connect the HD I/O Primary Port to DigiLink Mini Port 1 on the HDX card using a DigiLink Mini ca-

ble.

Figure 1. HD I/O connected to the DigiLink Mini Port 1 on an HDX card

To connect additional HD I/O audio interfaces:

1 After connecting the primary audio interface,
connect additional HD I/O (or other compatible
audio interfaces) by doing one of the following:

» Connect the Primary Port of the secondary in-
terface to the Expansion Port of the primary
interface with a DigiLink Mini cable.

» Connect the Primary Port of the secondary in-
terface to DigiLink Mini Port 2 on the HDX
card.

2 Repeat the preceding with additional HDX
cards.

3 Make the necessary Loop Sync connections
(see “Connecting Loop Sync” on page 14).
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Connecting Loop Sync

If you are using two or more HD audio interfaces
or a SYNC peripheral, Loop Sync must be con-
nected to maintain proper clock synchronization
among the devices. For an example of connecting
multiple Avid HD audio interfaces, see Figure 2 on
page 15. For examples that include a SYNC pe-
ripheral, see the SYNC HD Guide.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to
the Loop Sync In of the next interface with a
BNC cable.

2 Connect the Loop Sync Out of the last interface
to the Loop Sync In of the primary interface or
SYNC peripheral with a BNC cable.



First HDX card

Second HDX card

Figure 2. Making DigiLink and Loop Sync connections with two HDX cards, one HD OMNI, and five HD I/Os

Chapter 3: Connecting Pro Tools | HD I/O 15



Connecting Pro Tools | HD 1/0 to a Pro Tools | HD Native Card

To connect HD I/O to an HD Native card:

= Connect the HD I/O Primary Port to DigiLink Mini Port 1 on the HD Native card using the included
DigiLink Mini cable.

Figure 3. HD I/O connected to the DigiLink Mini Port 1 on an HD Native card

To connect two HD 1/Os to an HD Native card:

1 Connect the Primary Port to DigiLink Mini Port 1 on the HD Native card using the included DigiLink
Mini cable.

2 Connect the additional HD I/O (or other compatible Pro Tools audio interface) by doing one of the
following:

» Connect the Primary Port of the secondary interface to the Expansion Port of the primary
interface with an additional DigiLink Mini cable (or DigiLink to DigiLink Mini adapter).

» Connect the Primary Port of the secondary interface to DigiLink Mini Port 2 on the HD Native card.

3 Make the necessary Loop Sync connections (see “Connecting Loop Sync” on page 17).
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Connecting Loop Sync

If you are using two or more Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be
connected to maintain proper clock synchronization among the devices. For examples that include a SYNC
peripheral, see the SYNC HD Guide. For an example of connecting multiple Avid HD audio

interfaces, see Figure 4 below.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with a BNC
cable.

2 Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC
peripheral with a BNC cable.

Figure 4. DigiLink Mini and Loop Sync connections for two HD I/Os with HD Native

Chapter 3: Connecting Pro Tools | HD I/O 17
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Connecting Pro Tools | HD 1/0 to Pro Tools|HD Cards

To connect HD /O to a Pro Tools|HD card:

= Connect HD I/O Primary Port to the DigiLink Port on the first available Pro Tools|HD card with a Dig-
iLink cable (included with your Pro Tools|HD hardware) and a DigiLink Mini adapter.

12-foot DigiLink cable with
DigiLink Mini adapter

Figure 5. HD I/O connected to the DigiLink Port on a Pro Tools|HD Accel Core card (16-channel I/O system)

To connect multiple HD 1/Os to a Pro Tools|HD system:

1 Connect the Primary Port of the first HD I/O to the DigiLink Port on the Pro ToolsHD Accel Core card
with a DigiLink cable (included with your Pro Tools|HD system) and a DigiLink Mini adapter.

2 Do one of the following:

» Connect the Primary Port of the second HD I/O to the Expansion Port on the first HD I/O with the
included 18-inch DigiLink Mini cable.

» Connect the Primary Port of the second HD I/O to the next available Pro Tools|HD card with a
DigiLink cable and a DigiLink to DigiLink Mini adapter.

3 Connect additional HD I/Os to additional Pro Tools|HD cards.

4 Make the necessary Loop Sync connections.

Pro Tools | HD I/O Guide



Connecting Loop Sync

If you are using two or more Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be
connected to maintain proper clock synchronization among the devices. For an example of connecting
multiple Avid HD audio interfaces, see Figure 6 below.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with a BNC
cable.

2 Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC
peripheral with a BNC cable.

Pro Tools|HD Accel card

Figure 6. Making DigiLink and Loop Sync connections with two Pro Tools|HD cards, one HD OMNI,
and three HD I/Os

Chapter 3: Connecting Pro Tools | HD I/O
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Chapter 4: Configuring Pro Tools | HD 1/O in

Pro Tools | HD Software

This chapter explains how to configure
Pro Tools | HD Software for use with
Pro Tools | HD 1/0.

For more information about configuring
Pro Tools, see the Pro Tools Reference
Guide.

To change the default Sample Rate for new
sessions:

1 IfaPro Tools session is currently open, close it.
2 Choose Setup > Hardware.

3 From the Sample Rate pop-up menu, select the
sample rate that you want.

Hardware Setup

In the Hardware Setup dialog, Pro Tools lets you
set the default sample rate (if no session is open)
and clock source for your system, and provides ac-
cess to a range of controls specific to each type of
audio interface.

Default Sample Rate

The Sample Rate setting appears as the default
sample rate when you create a new session. (This
setting is available in the Hardware Setup dialog
only when no session is open.)

Q You can change the sample rate when
~ creating a new Pro Tools session by
selecting a different sample rate in the
New Session dialog.

Chapter 4: Configuring Pro Tools | HD I/O in Pro Tools | HD Software

Peripherals
HD OMNI #1

HDX #1, Port 1 Exp
Loop Master: HD OMNI #1

Sample Rate: m v 44.1 kHz
48 kHz h'
88.2 kHz

96 kHz
176.4 kHz
192 kHz

Selecting the default sample rate

4 Click OK.
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High Sample Rates and Expanded
Pro Tools|HD Systems

With 176.4 kHz and 192 kHz sample rates, as
many as four Pro Tools|HD cards can be used. Any
additional cards (up to the total system maximum
of seven cards) will switch to Inactive mode. The
Pro Tools|HD cards and any attached peripherals
will become active again when the sample rate is
set to 96 kHz or lower. See the Pro Tools
Expanded Systems Guide for more information.

Clock Source

The Pro Tools Hardware Setup dialog lets you set
the Clock Source for the system.

Internal If you are recording an analog signal
directly into Pro Tools, you will usually use the
Pro Tools Internal clock source.

External If you are transferring material into

Pro Tools from an external digital device, or if you
utilize a common house clock signal, you will need
to synchronize Pro Tools to that digital device or
common signal. Depending on your audio inter-
face configuration and the selected sample rate,
external options can include:

* S/PDIF [Encl] (at all sample rates)
» Optical (S/PDIF) [Encl] (up to 96 kHz)
* AES/EBU [Encl] (at all sample rates)

* AES/EBU 1-8 (Single Wire in stereo pairs at
all sample rates)

* AES/EBU 1-4 (Dual Wire) (in stereo pairs at
176.4 and 192 kHz)

* ADAT 1-8 (at 44.1 and 48 kHz)

* ADAT S/MUX 1-4 (at 88.2 and 96 kHz)

* ADAT S/MUX 1-2 (at 176.4 and 192 kHz)
* TDIF 1-8 (at 44.1 and 48 kHz)

» Optical ADAT [Encl] (at 44.1 and 48 kHz)
* Word Clock (at all sample rates)
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To select the Clock Source:

1 Choose Setup > Hardware.

2 From the Clock Source pop-up menu, select the
clock source.

Peripherals Interface: HD 1/O
HD OMNI #1 Main

Input

1-2 | Analog 1-2 B
Analog 3-4

HDX #1, Port 1 Exp

Loop Master: HD I/O #1 9-10

P 44.1 kHz 11-12

HD OMNI #1 » [GUclE)

Clock Source: * HD 1/0 #1

* v Internal [\
A3
AES/EBU [Encl] ™
Optical (ADAT) [Encl]
Word Clock (44.1kHz)

Selecting the Clock Source

3 Click OK.

A Your digital input device must be connected
and powered on for Pro Tools to synchronize
to it. If your input device is not powered on,
leave the Clock Source set to Internal.



Identify

If you have multiple audio interfaces of the same
type connected to your system, you should confirm
the identity of each interface. This ensures that you
select the appropriate interface in the Peripherals
list when defining its inputs and outputs, and other
settings, in the Hardware Setup dialog.

To identify audio interfaces in your system:

1 Choose Setup > Hardware.

2 From the Peripherals list, select an audio
interface connected to your system.

Use the Up and Down Arrow keys to scroll
though the Peripherals list in the Hardware
Setup dialog.

3 Select the Identify option, located in the lower
left corner of the Hardware Setup dialog. This
illuminates all the LEDs on the front panel of
the selected audio interface.

4 Make a note of which interface in your studio
setup corresponds to the identified interface.

5 Repeat the above steps for each additional audio
interface in your setup.

Configuring HD 1/0

To configure controls for HD 1/O:

1 Choose Setup > Hardware.

2 From the Peripherals list, select the HD I/O
audio interface.

3 Click the Main tab and configure the options.

Hardware Setup
peripherals Intertace: HD 10
Input ouput
12 (Anaiogt2 T gtz ¥ Dtal Fomat
34 (Amiogsh 3 = > ©naesEsu
HDX #1, Port 1 Exp. 56  Analog56 7 Analog56 = "
Opteal (SO
Clock Source: [ntemal M e = - pical (SIPDIF)
e
Loop Maste: HD OMNI #1 ot = 5 O e
‘Sample Rate: (441 Kbz - P
1112 (Anog 12 T macg itz -
116 (Ao 184 T naog 1314 -
1516 (Amog 1518 T o 1516 -
Ext ook Output Werd Cock (441 kHe)
) ieruty

HD I/O Hardware Setup, Main page

4 Ifyou have at least one HD I/O AD card, click
the Analog In tab and configure the options. If
you have two HD I/O AD cards, this tab is la-
beled Analog In 1-8.

Hardware Setup
erghenls e K010
0 oM #1 e
e v

ch1 @ +4dBu 1008V None. e

ch2 @ +4dBu 1008V None. e
HDX #1, Port 1 Exp. ch3 @ +4dBu 1008V None. e
ok Source: i 2| o @wa 0wy i -
Loop st HO OMNI#1 s @ et qowv None -
SanpleRate: datide T | o6 @ waomu “t0d8v Nono 3

ch7 @ +4dBu 1008V None. -

che @ +4dBu 1008V None. -
) 1dentity.

HD I/0O Hardware Setup, Analog In page
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5 If you have two HD I/O AD cards, click the An-
alog In 9-16 tab and configure the options.

Hardware Setup

Peripherals Interface: HD IO
HD OMNI #1

Analog In 916

Referonce Lovel:

cho @ +4cBu “t0av
chio @ +4cBu “t0ay
it @ w4cBu “t0ay
iz @ wcBu “t0dv

HOX#1, Port 1 Exp
Gock Source: Inemal
Loop Master: HD OMNI #1
‘Sample Rate: (441 bz

i3 @ w4cBu “t0d8v
4 @ vacBu “t0dy
cnis @ +4cBu “t0dy
cnis @ +4cBu “t0d8y

EEEE EEER:

(] identity

| setoverut | ok ]

HD I/0 Hardware Setup, Analog In 9—16 page

6 If you have at least one HD I/O Digital card,
click the Digital tab (this is labeled Digital 1-8 if
you have two HD I/O Digital card installed) and
configure the options.

Hardware Setup

Peripherals

T —— 0

> HD IO #1

DigitalFormat: Sample Rate Conversion:
@ Abs/EBU1-8 Ochi-2
O AvaT1-8 Ochae
O ori-s Onss
Oonrs

Loop Master: HD OMNI #1

Sample Rate:

(44.1 kHz [
O ersty Commmi ) —

HD I/0 Hardware Setup, Digital page

Q At session sample rates above 48 kHz, sample
" rate conversion for the TDIF and Optical
(ADAT) inputs on the HD I/O Digital card is
automatically enabled on all eight inputs of
the selected format unless you are using
S/MUX Optical.

7 If you have two HD I/0O Digital cards installed,
click the Digital 9—16 tab and configure the
options.

8 When you are finished, click OK.
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HD 1/0 Hardware Setup Options

HD 1/O provides multiple pages of Hardware
Setup options depending on the configuration.

Main Page

HD 1/O supports up to sixteen channels of
simultaneous input and output in multiple I/O
formats (including analog, AES/EBU, ADAT
Optical, S/MUX, S/PDIF, and TDIF).

The Main page of the Hardware Setup dialog is
where you define which physical inputs and out-
puts on your audio interface are routed to available
input and output channels in Pro Tools. You can
think of this window as a patchbay that lets you
route any of the input pairs or output pairs on your
Pro Tools audio interfaces to channel assignments
in the Pro Tools mixer.

Hardware Setup

Perpherals
HOMo# T T nerface (1
>HD 1072

nput output Digital Format:
1-2 (Analog 1-2 Analog 1-2 s @ Ass/esu
Anslog -4 5 Oswor

O optical (5/¢DIF)

3-4 (Analog 3-4
HD Core #1

5-6 (Analog 5-6 Analog 5-6

7-8 [(Analog 7-8 Analog 7-8

Ext. Clock Output: (Word Clock (96 kiz) +

Sy ()

HD I/O Hardware Setup, Main page (8 x 8 x 8 shown)



Input

Select the corresponding physical inputs from the
Input pop-up menu for each stereo pair of

Pro Tools Input channels (1-2, 34, ...15-16).
Which physical inputs are available depends on the
sample rate and on which HD I/O Expansion cards
you have installed (for example, if no HD I/O AD
card is installed, no analog inputs will be avail-
able).

Q These settings are saved with the system, not
with the session.

Output

Select the corresponding physical outputs from the
Output pop-up menu for each stereo pair of

Pro Tools Output channels (1-2, 3-4, ...15-16).
Which physical outputs are available depends on
the sample rate and on which HD I/O Expansion
cards you have installed (for example, ifno HD I/O
DA card is installed, no analog outputs will be
available).

Q These settings are saved with the system, not
with the session.

Control-click (Mac) or Start-click (Win-
dows) to select multiple Inputs or Out-
puts. Command-Option-click (Mac) or
Control-Alt-click to cascade all Input or
Output settings.

Inputs and Outputs of Similar Formats

Inputs and outputs of similar formats are differen-
tiated in the input and output channel pop-up
menus. For example, the AES/EBU inputs and out-
puts in the HD I/O enclosure are listed as
AES/EBU [Encl], while the AES/EBU inputs and
outputs on a HD I/O Digital card are listed (in
pairs) as AES/EBU 1-2, AES/EBU 3-4, AES/EBU
5-6, and AES/EBU 7-8. For HD 1/Os equipped
with an second Digital card, the additional
AES/EBU I/O ports on the optional card are listed
as AES/EBU 9-10, AES/EBU 11-12, AES/EBU
13-14, and AES/EBU 15-16.

Digital Format

Select from the following digital input formats for
the built-in digital I/O enclosure (configure the op-
tions for any additional HD I/O Digital cards by
clicking the corresponding Digital tab):

AES/EBU Provides up to two channels of
AES/EBU input.

S/PDIF Two channels of S/PDIF (coaxial) input.

Optical (S/PDIF) Two channels of S/PDIF (optical)
input up to 96 kHz. This option is not available at
sample rates higher than 96 kHz.

S/PDIF Format

For S/PDIF (Sony/Phillips Digital Interface For-
mat) compatibility with Tascam DA-30 DAT re-
corders, select the Tascam option under S/PDIF
Format.

Chapter 4: Configuring Pro Tools | HD I/O in Pro Tools | HD Software
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Ext. Clock Output

If you want to send clock output to other devices
attached to HD 1/0, select the appropriate output
from the Ext. Clock Output pop-up menu.

The available options for Ext. Clock Output change
depending on the session sample rate. See the table
below for a list of default external clock settings
and available options.

Ext. Clock Output options by sample rate

Sambple Rate Available Ext. | Available Ext.
P Clock Default | Clock Option
44 1 kHz Word Clock N/A
(44.1 kHz)
48 kHz Word Clock N/A
(48 kHz)
88.2 kHz Word Clock Word Clock
(88.2 kHz) (44.1 kHz)
96 kHz Word Clock Word Clock
(96 kHz) (48 kHz)
176.4 kHz Word Clock Word Clock
(176.4 kHz) (44.1 kHz)
192 kHz Word Clock Word Clock
(192 kHz) (48 kHz)

Analog In Page

The Analog In page of the Hardware Setup dialog
lets you set the Reference Level for the physical
analog inputs on HD I/O. You can also apply a lim-
iter to each of the available analog inputs.

If you have only a single HD I/O AD Expansion
card installed, a single Analog In tab is available. If
you have two HD I/O AD Expansion cards in-
stalled, the tabs Analog 1-8 and Analog 9-16 are
available. The Analog In, and Analog 1-8 and Ana-
log 9-16 pages provide the same controls for the
corresponding physical inputs on the HD /O AD
card. If no HD I/O AD Expansion card is installed,
these tabs are not available.
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Hardware Setup

Interface: HD IO

Refersnce Level: Liiter
o1 @ +4ceu “t0dv Nons
ch2 @ +4ceu “t0dv Nono

HOX #1, Port 1 Exp
(Clock Source: Intormal

h3 @ +4cBu “t0dv Neno
e @ +4cBu “t0dv Nono
Loop Maste: HD OMNI 1
‘Sample Rate: 441 bz

chs @ +4cBu “t0d8v Nene
che @ +4cBu “t0d8v Nene
7 @ +4cBu “t0d8v Nene
s @ +4dBu “t0d8v Nene

——

Hardware Setup, Analog In page

Reference Level

Select the appropriate Reference Level for each of
the available analog input channels. This lets you
select the analog audio input source on a channel-
by-channel basis. The +4 dBu option routes audio
from the physical +4 dBu Balanced DB-25 Analog
Input port on the card. The —10 dBV option routes
audio from the physical -10 dBV Balanced DB-25
Analog Input port on the card.

SEBEEREARBEEN
CLLL LI LIS

+4 dBu and —10 dBV DB-25 Analog Input ports
Limiter

HD 1/O provides options for soft limiting on each
of the available analog input channels. Select the
desired option from the corresponding Limiter pop-
up menu:

None Applies no limiting to the incoming analog
signal.

Soft Clip Attenuates the incoming analog signal,
providing extra protection from temporary clip-
ping transients that can cause digital distortion
when they exceed the maximum input of the unit.



With Soft Clip enabled, HD I/O supports an addi-
tional 4 dB of headroom by rounding off the top
4 dB to the clip point. This is useful for eliminating
stray transients.

Curv Attenuates the incoming analog signal using
a soft knee limiter circuit. This guarantees super
soft limiting without becoming hard, even with
large overloads on input.

Digital Page

The Digital page of the Hardware Setup dialog lets
you set the Input Format and Sample Rate Conver-
sion for any Digital I/O cards installed in HD 1/O.

If you have only a single Digital I/O card installed,
a single Digital tab is available. If you have two HD
/O Digital Expansion cards installed, the tabs Dig-
ital 1-8 and Digital 9-16 are available. The Digital
(one Digital card), or the Digital 1-8 and Digital
9-16 (two Digital cards) pages all provide the
same controls for the corresponding physical in-
puts on the HD I/O Digital card. If no HD I/O Dig-
ital Expansion card is installed, these tabs are not
available.

Hardware Setup

reripherals
T —— 0
>HD IO #1

Digital Format
© AES/EBU1-8

Sample Rate Conversion:
Qchi1-2
QOch3-a
QOchs-6
QOch7-8

O ADAT 1-8

HDX#1, Port 1, Exp O TF1-8

Clock Source

Sample Rate:

(a1 iz =

ety (SerTo pefau )

HD I/0 Hardware Setup, Digital page

Q At session sample rates above 48 kHz, sample
" rate conversion for the TDIF and Optical
(ADAT) inputs on the HD I/O Digital card is
automatically enabled on all eight inputs of
the selected format—unless you are using
Optical (ADAT S/MUX).

Digital Format

Select from the following digital formats for the
HD 1/O Digital card. Depending on the sample

rate, different Digital Format options are available.

Peripherals

HD OMNT#1 Interface: HD 110
>HD IO #1 Main |_Analog In | Digital
AHD MADI DigiLink 1
Digital Format: Sample Rate Conversion:
© AES/EBU 1-8 Ochi-z
() ADAT 1-8 [ ch3-a
HD Core PCle #1, Exp O TOF1-8 e
Clock Source: Och7-8

[internal B
Loop Master: HD OMNI #1
Sample Rate:

[[44.1 khz )]

HD I/0 Hardware Setup, Digital Format options at
44.1 kHz

Peripherals

HD OMNT#1 Interface: HD 110
>HD IO #1 Main |_Analog In | Digital
AHD MADI DigiLink 1
Digital Format: Sample Rate Conversion:
AES/EBU Ochi-z
® Ags/EBU 1-8 Och3-a
HD Core PCle #1, Exp ADAT Sichlete
Clock Source: (S ) Ocnz-8
(Cinternal ] Blazecan)
Loop Master: HD OMNI #1 g
O 1-8 5RO
Sample Rate:
[ 96 kHz. )]

HD I/O Hardware Setup, Digital Format options at
96 kHz

Peripherals
D ORea 1 Interface: HD IO
ZhlEL L] Main |_Analog In_| Digital
AHD MADI DigiLink 1
Digital Format. Sample Rate Conversion:
AES/EBU Qch1-2
® 1-8 (single wire ey
HD Core PCle #1, Exp O 1-4 (Dual Wire) Ochs-6
Clock Souree: ADAT: Ocnz-s
(internal B 2 )
Loop Master: HD OMNI #1 Ei2/m00
cample Rate: TOIF
ek O 1-86RO)
[ 192 kHz )]

HD I/0 Hardware Setup, Digital Format options at
192 kHz
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AES/EBU

You can select up to eight channels of AES/EBU
input depending on the sample rate. At sample
rates of 44.1 kHz to 96 kHz, the only option avail-
able is AES/EBU 1-8 (or AES/EBU 9-16 for the
second card, if present). At sample rates of

176.4 kHz and 192 kHz, two AES/EBU options
are available (Single Wire and Dual Wire modes).

AES/EBU 1-8 Enable this option for eight chan-
nels of AES/EBU input. This is the only option
available at sample rates of 44.1 kHz to 96 kHz.
This option is not available at higher sample rates.

AES/EBU 1-8 (Single Wire) Enable this option for
eight channels of AES/EBU input. Sample Rate
Conversion is available for stereo pairs when Sin-
gle Wire mode is selected. This option only ap-
pears at sample rates of 176.4 kHz and 192 kHz.

AES/EBU 1-4 (Dual Wire) Enable this option for
four channels of AES/EBU input at sample rates of
176.4 kHz and 192 kHz. Sample Rate Conversion
is not available in Dual Wire mode. This option
only appears at sample rates of 176.4 kHz and
192 kHz.

ADAT

You can select up to eight channels of ADAT input
depending on the sample rate. At 44.1 kHz and
48 kHz, the only option available is ADAT 1-8 (or
ADAT 9-16 for the second card, if present). At
sample rates of 88.2 kHz and higher, two ADAT
options are available (SRC and S/MUX).

ADAT 1-8 Enable this option for eight channels of
ADAT input. This is the only option available at
sample rates of 44.1 kHz and 48 kHz. This option
is not available at higher sample rates.
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1-8 (SRC) Enable this option for eight channels of
ADAT input with automatic Sample Rate Conver-
sion (SRC). This option only appears at sample
rates of 88.2 kHz and higher. This option is not
available at 44.1 kHz and 48 kHz.

1-4 (S/IMUX) Enable this option for four channels
of ADAT input with S/MUX (sample multiplex-
ing). This option only appears at sample rates of
88.2 kHz and 96 kHz.

1-2 (S/MUX) Enable this option for two channels
of ADAT input with S/MUX (sample multiplex-
ing). This option only appears at sample rates of
176.4 kHz and 192 kHz.

TDIF

Depending on the sample rate, you can select eight
channels of TDIF (Tascam Digital Input Format)
input—TDIF 1-8, or TDIF 9-16 for the second
card, if present—with or without automatic Sam-
ple Rate Conversion (SRC).

TDIF 1-8 Enable this option for eight channels of
TDIF input. This option is only available at sample
rates of 44.1 kHz and 48 kHz.

1-8 (SRC) Enable this option for eight channels of
TDIF input with automatic Sample Rate Conver-

sion. This option is only available at sample rates
of 88.2 kHz and higher.



Sample Rate Conversion

Sample Rate Conversion (SRC) is independently
available for AES/EBU stereo input pairs at all
sample rates. When Digital Format is set to ADAT
or TDIF, SRC can only be enabled or disabled for
all channel inputs. Sample Rate Conversion on In-
put is only available for Digital I/O cards, it is not
available for the enclosed digital ports.

A\ Digital outputs do not support sample rate
conversion.

A Sample Rate Conversion adds latency to the
input signal, so you should usually disable
Sample Rate Conversion when it is not
needed.

Q At session sample rates above 48 kHz,
sample rate conversion for the TDIF and
Optical (ADAT) inputs on the Digital 1/0
card is automatically enabled on all eight
inputs of the selected format—unless you
are using Optical (ADAT S/MUX).

AES/EBU

When Digital Format is set to AES/EBU, SRC can
be enabled or disabled for each stereo input pairs at
sample rates of 44.1 kHz to 96 kHz, and at

176.4 kHz and 192 kHz in Single Wire mode.
Sample Rate Conversion is not available for
AES/EBU at 176.4 kHz and 192 kHz in Dual Wire
mode.

Peripherals
"HDOmNI®T Interface: HD /O
> HD 10 #1
AHD MADI DigiLink 1

Digital Format: Sample Rate Conversion:

AES/EBU ™chi-2
® AES/EBU 1-8 & chis
HD Core PCle #1, Exp ADAT Dl
Clock Source 9 L) Och7-8
(onernal ) SRR
Loop Master: HD OMNI #1 o
0 1-8 6RO
Sample Rate

SRC enabled for AES/EBU Input channels 1-2 and
3-4 at a Sample Rate of 96 kHz

ADAT

For sample rates of 44.1 kHz and 48 kHz, when
Digital Format is set to ADAT, Sample Rate Con-
version can be enabled or disabled for all inputs.

ADAT (SRC)

At sample rates higher than 48 kHz, with ADAT
(SRC) selected as the Digital Format, Sample Rate
Conversion is enabled automatically for all

input channels.

ADAT (S/MUX)

At sample rate higher than 48 kHz, with ADAT
(S/MUX) selected as the Digital Format, Sample
Rate Conversion can be enabled or disabled for all
input channels.

TDIF

For sample rates of 44.1 kHz and 48 kHz, when
Digital Format is set to TDIF, Sample Rate Conver-
sion can be enabled or disabled for all inputs.

TDIF (SRC)

At sample rates higher than 48 kHz, with TDIF
(SRC) selected as the Digital Format, Sample Rate
Conversion is enabled automatically for all

input channels.

Set To Default

The Set To Default button sets all settings to the
factory defaults, except for the Digital Format set-
ting in the Main page.

Chapter 4: Configuring Pro Tools | HD I/O in Pro Tools | HD Software

29



Using Input Trims

Input Trims

Input Trims

The Input Trims below the two DB-25 connectors
on the HD I/O AD Expansion card are used to store
a calibration settings for each channel. These ad-
justable Input Trims are for precisely calibrating
the adjustable headroom settings for each channel.
You can adjust each Input Trim by hand with a
small screwdriver.

About Input Operating Levels

Check the manufacturer’s documentation for your
mixer, power amplifier, or effects processor to see
if it operates more comfortably at line level, in
which case consider setting the HD 1/O to operate
at —10 dBV line levels and adjusting the Input
Trims.
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Consider the following when connecting a mixer:

o If your mixer cannot handle more than 1.5V
(RMS) inputs at +4 dBu, then you should set the
HD 1/O to operate at —10 dBV line level.

o If your mixer can handle up to 15.5V (RMS) in-
puts, or has pads or attenuators on its inputs, then
you can use the +4 dBu setting on the HD 1/0O.

o HD I/O is calibrated at the factory for 18 dB
headroom at the +4 dBu setting.

Most manuals contain device input specifications,
including whether or not there are pads or attenua-
tors. Refer to the manufacturer’s documentation
for your mixer or power amplifier for more infor-
mation.

Q If you want to switch the input levels of the
~ HD I/O from +4 dBu to—10 dBV, you can ac-
cess these parameters on a channel-by-chan-
nel basis in the Hardware Setup dialog (see
“Hardware Setup” on page 21).



Chapter 5: Adding or Removing 1/0 Cards

Pro Tools | HD 1/O has four Expansion I/O bays
on the back of the unit. Depending on which ver-
sion of HD I/O you purchased, one, two, or none of
these bays may be empty and available for addi-
tional I/O cards:

* 8 x 8 x 8: three bays are used and the fourth bay
is empty

* 16 x 16 Analog: all four bays are used

* 16 x 16 Digital: two bays are used and two are
empty

The Expansion I/0 bays let you configure HD 1/0
with any of the following Expansion I/O cards
(each sold separately) to increase the amount of
available I/O on the unit:

* HD I/O AD Expansion card
* HD I/O DA Expansion card
» HD I/O Digital Expansion card

A\ 1tis important that you follow the guidelines in
this chapter to avoid damaging your HD 1/0
or any of your I/O Expansion cards.

The factory-installed cards can be removed, if
needed, for servicing, or to swap out cards for dif-
ferent studio setups. If you remove any of the cards
from the HD I/0O, the unit will continue to function
as long as at least one card is installed (albeit with
reduced I/O capabilities).

A\ Legacy 192 1/0 AD, DA, and Digital Option
cards are not supported with HD I/O. Any
attempt to install legacy 192 I/O cards will
void the warranty for your HD I/O.

Removing an 1/0 Card

To remove an Expansion I/O card:

1 Power off and disconnect the HD I/O from your
system.

2 Make sure that the equipment is properly
grounded.

A\ Before handling any of the cards or internal
components of HD I/O, discharge any static
electricity by touching the outer casing of the

power supply.

3 Remove all of the small Phillips-head screws
around the edges of the top cover. Put the
screws in a safe place.

Removing the top cover screws

4 Lift off the top panel of the HD I/O and set it
aside.

Chapter 5: Adding or Removing I/O Cards
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5 Remove the screws on the back panel for the
/O card you want to remove.

Removing the screws securing an I/O card

6 Holding the 50-pin cable which connects the
card to the HD I/O chassis firmly, gently pull
the cable connector from the card’s connector.

e

7 Gently remove the card, pulling it straight out
from the chassis.

& (1A AT

Removing an I/O card from the HD I/O chassis
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A When you pull a card out, pay particular at-
tention to keeping components on the sur-
faces of the card from bumping into any of
the internal components or the back panel
faceplate on the HD 1/0.

8 Place the card in a static-free bag and keep it in
a safe place (if you are not sending it to Avid for
service).

9 Firmly grasp the 50-pin cable connector to the
HD I/O chassis and gently pull to remove it (be
sure to keep the cable in a safe place).

10 If you have a cover for the empty expansion
bay, secure the cover over the empty bay with
the screws you removed from the I/O card.

11 Replace the top cover on the HD 1/O.

12 Replace the original screws.

Hardware Setup Changes After
Removing a Card

In this case, the Hardware Setup dialog will reflect
the change to the installed I/O cards. The remain-
ing inputs and outputs will function normally.

For example, if you remove the Analog Input card,
the Analog Input tab will disappear from the Hard-
ware Setup dialog.

You will lose the configuration of any pairs of in-
puts or outputs that were assigned to the card being
removed.



Installing an Expansion /0
Card

To install an Expansion I/O card:

1 Power off and disconnect the HD I/O from your
Pro Tools|HD system.

2 Make sure that the equipment is properly
grounded.

3 Remove all of the small Phillips-head screws
around the edges of the top cover. Put the
screws in a safe place.

4 Lift off the top of the HD I/O and set it aside.

5 If necessary, do one of the following:

* Remove the screws on the cover over the
empty bay where you want to install an Ex-
pansion card.

* Remove the currently installed I/O card that
you want to replace (see “Removing an I/O
Card” on page 31).

6 Look into the empty bay to locate the guide rails
for the card to slide in on.

ANALOG OUTPUT

Guide rails along sides of empty bay

7 Remove the Expansion I/O card that you want
to install from its static-free bag.

A\ Before handling any of the cards or internal
components of HD /O, discharge any static
electricity by touching the outer casing of the

power supply.

8 Slide the edges of the card into the guide rails on
each side of the bay.

Savab, meh
by MG rriin

L
- -

Inserting the card into the guide rail.

s for the empty bay

9 Gently push the card back into the bay, lifting
slightly to keep components underneath the
card from touching the back panel.

Lifting slightly while pushing the card back into the bay

Chapter 5: Adding or Removing I/O Cards
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10 Secure the I/O card to the back panel of the
HD 1/O chassis with the same screws you re-
moved from the either the empty bay cover or
from the 1/O card you previously removed.

Securing the I/O card to the back panel of the HD I/O

11 Locate the raised ridge in the middle of the con-
nector on one end of the 50-pin cable that con-
nects the I/O card to the HD I/O chassis. This
ridge is only on one side of the connector, and
there is a matching groove on only one side of
the 50-pin connector on the chassis.

12 Gently push the cable connector into the chas-
sis’ connector. The ridge on the cable connector
must line directly into the groove on the chassis
connector. Be very careful not to bend any of
the pins.

A Y .".
Connecting the 50-pin cable to the HD I/O chassis
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13 Locate the raised ridge in the middle of the con-
nector on the other end of the 50-pin cable that
connects the I/O card to the HD I/O chassis.
This ridge is only on one side of the connector,
and there is a matching groove on only one side
of the 50-pin connector on the card.

14 Gently push the cable connector into the card’s
connector. The ridge on the cable connector
must line directly into the groove on the card
connector. Be very careful not to bend any of
the pins or to over-stress the card.

Pressing the 50-pin cable connector into the card

15 Replace the top cover on the HD 1/O.
16 Replace the original screws.

17 Reconnect the HD I/O to your system.
18 Power on the HD I/O.

19 When you power on the unit, verify that the
LED ring around the power switch lights or-
ange.

20 Start up the computer.

21 When you start the computer, verify that the
power ring turns from orange to green. (If this
does not occur, see “Troubleshooting” on
page 35.)

22 Launch Pro Tools.



23 Open the Hardware Setup dialog to confirm that
the new card is recognized:

» Ifyouinstalled a Digital Expansion card, you
should see a new tab called “Digital 9-16.”

 Ifyou installed an AD Expansion card, you
should see a new tab called “Analog In
9-16.”

24 If the new card does not appear in the Hardware
Setup dialog, power down, check the seating of
the card, and recheck the cable connections in-
side the HD 1/O.

Hardware Setup Changes After Adding
a Card

Any additional inputs and outputs provided by the
new card will appear in the Hardware Setup dialog,
with the same controls and parameters as for the
original card of the same type.

For example, if you add an Analog Input card to
the original three cards, a second Analog Input tab
will appear in the Hardware Setup dialog. You can
route these new inputs (which will in this case be
called Analog Inputs 9-16) with the same controls
and parameters as the factory-installed version of
the card.

(Y Whenever a card is added or removed from a
* HD I/O, the routing in the Hardware Setup
dialog reverts to the default assignments. If
you have complex routing and or mirroring in
place, note the assignments and reassign the
inputs and outputs after the new card has
been properly identified.

Troubleshooting

If the power ring does not turn from orange to
green when you boot the computer, check the fol-
lowing:

* Make sure the DigiLink Mini cable is connected
to the Primary port on the back of the unit.

* Make sure that the 50-pin cables used to connect
the installed I/O cards to the chassis are firmly
connected.

Chapter 5: Adding or Removing I/O Cards
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Chapter 6: Pinout Diagrams for the DB-25
Connectors

Analog Output DB-25 Analog Input (+4 dBu) DB-25

CHl_WoT |24 CH1_HoT |24
1 |ceicopp22 1 | cwi_cowo |12
CH1_GND i; CH1_GND i;
CHZ_HOT CH2_HOT
2 cH2_colp |23 2 cH2_colp |23
cH2_oNp [ 1L cH2_oNp |11
cr3_wot |-2L ch3_vot |21
3 cH3_cotp |2 3 | cu3_cown |2
CH3_GND |22 CH3_GND |22
7 7
CHA_HOT CHA_HOT
4 | cha_cop 20 4 | cHa_cop |20
8
CH4_GND CH4_GND
CH5_noT |18 CH5_roT |18
5 cHs_coLp |- & 5 cH5_coLp |6
CH5_GND |19 cH5_GND |19
CH6_HoT -4 CH6_HOT |-+
6 | cHé_colp ;7 6 | cHé_cop 17
CH6_GND CH6_GND |2
CH7_HoT |12 CH7_HoOT |12
7 cH7_coLp |3 7 CH7_coLp |3
CH7_GND |16 CH7_GND |16
1 1
CHB_HOT CHB_HOT
8 | cus_cop [ 14 8 | cHs_cop |14
CHB_GND |2 CHB_GND |2
NC_1 ;34- NC_1 L.
wH1 |26 mH1 |26
MH2 |27 w2 |27
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Analog Input (-10dBV) DB-25

CcH1_HoT |24
1 | cHicown 12
CH1_GND |25
cHz_not |10
2 cH2_colp |23
cH2_GND |11
cn3_not 21
3 | cu3_cowp |2
CH3_GND |22
CHA_roT |-L
4 cH4_coLp |20
CH4_GND |-
CH5_HoT |18
5 | cus_cop |-6
CH5_GND |12
CH6_HOT |-+
6 | cHe_cop |17
CH6_GND |2
CH7_HoT |12
7 | cv7_cowp |3
CH7_GND |16
CHB_HoT |-L
8 | cHs_cop [ 14
CHB_GND |2
N LB
mH1 |26
mH2 |27
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AES/EBU DB-25

CH12_RCV_HOT
CH12_RCV_COLD
CH12_RCV_GND

24
12
25

CH34_RCV_HOT
CH34_RCV_COLD
CH34_RCV_GND

10

23

11

CH56_RCV_HOT
CH56_RCV_COLD
CH56_RCV_GND

21

22

CH78_RCV_HOT
CH78_RCV_COLD
CH78_RCV_GND

20

CH12_XMT_HOT
CH12_XMT_COLD
CH12_XMT_GND

18

19

CH34_XMT_HOT
CH34_XMT_COLD
CH34_XMT_GND

17

XMT

CH56_XMT_HOT
CH56_XMT_COLD
CH56_XMT_GND

15

16

7-8
XMT

CH78_XMT_HOT
CH78_XMT_COLD
CH78_XMT_GND

14

NC_1
MH1
MH2

13
26

27




TDIF DB-25

CHIZ_RCV_DATA |13
< 1-2 GNDL |23
= 3-4 CH34_RCV_DATA |12
g - GND2 |24
5_6 CH56_RCV_DATA |11
3 B GNp3 [23
x 7-8 CH78_RCV_DATA |10
B GND4 iz
CH12_XMT_DATA
< 1-2 GNDS ;4
= CH34_XMT_DATA
g 3-4 GND6 ;5
CH56_XMT_DATA
= 5-6 oNp7 |16
X 7-8 CH78_XMT_DATA |4
B GND8 |17
RCV_LRCK |2
RCV RCV_EMPHASIS L-Nc=
CLK+CTRL Rov_Fs1 |8 mnc=
RCV_FSO 29 mNnc=
XMT_LRCK |2
XMT XMT_EMPHASTS | 18
CLK+CTRL xr_ps1 | 19 |
XMT_FS0 |-©
GND9 |7
mH1 [ 26
mH2 |27

DB25F_RA_TDIF

GND_C

FB30 FB31
T T
22PF 22pPF

GND_C Gyp_a  GND_C Gnp_a
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Chapter 7: HD 1/0O Calibration Mode

Instructions

Before you use Pro Tools | HD 1/0, you may want
to calibrate its input and output levels to the level
of your mixing console.

The HD 1/0O has +4 dBu and —10 dBV inputs, and
+4 dBu outputs, each with its own trim pot for
proper calibration.

The HD I/O is factory-calibrated so that its +4 dBu
input operating level is set for 18 dB headroom
above +4 dBu (maximum input/output +22 dBu).

If you need to recalibrate your HD I/O or other
components of your studio, you can use the align-
ment procedure described in this chapter.

About Calibration

Calibrating levels on a digital recording device is
different from calibrating levels on an analog re-
cording device. Unlike analog devices, most digi-
tal devices do not have a standard “0 VU” level
setting that corresponds to nominal input and out-
put levels. Instead, with an interface such as the
HD I/0, the meters are calibrated in decibels below
peak or dBFS (dB full scale)—digital clipping
level.

Headroom

The concept of headroom is slightly different for
analog and digital devices.

Analog Most analog devices allow for a certain
amount of headroom above 0 VU. If you send a
signal above 0 VU to an analog recorder, you still
have a margin of headroom, and if tape saturation
occurs, it does so fairly gracefully, giving the au-
dio a compressed sound that some find desirable.

Digital Digital devices do not allow for signals that
exceed the dynamic range of the input or dBFS (dB
full scale). When a signal exceeds the maximum
input level for a digital device, clipping occurs,
causing digital distortion, which is harsh and usu-
ally undesirable.

The Calibration Process

Analog To calibrate the input level of an analog
device to a mixing console’s output level, you
would typically send a 1 kHz tone at 0 VU from
the console to the analog deck and align the record-
ing deck’s meters to read 0 VU.

Digital With a digital recording device such as the
HD 1/0O, in order to allow for headroom, you must
align a 0 VU tone from the console to a value less
than zero (or below dB full scale [-x dBFS]) on
the HD I/O, by exactly the amount of headroom
that you want.

Chapter 7: HD I/O Calibration Mode Instructions
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For example, to have 12 dB of headroom above

0 VU with the HD 1/0, you must align the incom-
ing 0 VU 1kHz tone to a level of —12 dBFS. For
18 dB of headroom, you would align it to

—18 dBFS. (Since it is assumed that you are using
the HD I/O with a +4 dBu device or console, a

0 VU signal level coming out of the device or con-
sole is actually equivalent to a nominal +4 dBu
level signal.)

Calibrating the HD 1/O

To calibrate your HD 1/O, use one of the HD 1/O
calibration sessions included with Pro Tools (lo-
cated in the Pro Tools Utilities/Calibration Mode
Session/HD 10 Calibration Session folder). You
can use these sessions as is and change the input
and output assignments for more HD 1/O channels
oruse it as a template to make your own calibration
session.

The following instructions show how to create a
calibration session from scratch.

Q If your system includes one or more EUCON
= controllers, be sure to disable “Auto-bank to

selected track” in EuControl software before
enabling Pro Tools Calibration Mode to en-
sure that faders remain silent. To make sure
“Auto-bank to select track” is not enabled,
open the EuControl Settings window, click to
go to the General tab, and verify the setting is
not enabled. If necessary, click to disable
“Auto-bank to selected track.” After exiting
Calibration Mode, be sure to re-enable the
“Auto-bank to selected track” setting (if nec-

essary).

A Turn down your monitoring system before
beginning calibration. The Signal Generator
plug-in emits a continuous signal when in-
serted on a track.
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To create a session for calibrating your HD 1/O:

1 Launch Pro Tools and create a new session.

2 Choose Setup > Preferences and click the Op-
eration tab.

3 Enter the desired Calibration Reference Level
value in dB. A level of —18 dB is typical. (It is
not necessary to type a minus sign here.)

4 Click OK.

5 Create a new mono audio track by choosing
Track > New.

6 Insert the Signal Generator plug-in on the track.

7 Set the Signal Generator plug-in output level.
This should be the same value you entered as
the Calibration Reference Level (such as
—18 dB).

8 Set the Signal Generator frequency to 1000 Hz.
1000 Hz s typical, but any frequency will work.
Other typical values are 250 Hz and 500 Hz.

9 Set the Signal Generator signal waveform to
Sine.

10 Route the track’s output to Bus 1. In the calibra-
tion template, Bus 1 has been renamed to “1k
Tone.”

11 Create a mono Auxiliary Input track for each
HD 1/O output you want to calibrate. Set the
output assignment for each of these Auxiliary
Inputs to its respective 1/O output.

12 Set the input of each Auxiliary Input track to
Bus 1, or 1k Tone for the template session.



13 Create an additional mono Auxiliary Input track
for each input you want to calibrate. Set the in-
put assignment for each of these Auxiliary In-
puts to its respective I/O input. Then set the
output of each of these Auxiliary Inputs to an
unused bus pair (for example Bus 3—4). In the
template session the bus names are Null and
Out. This makes sure feedback doesn’t occur
when monitoring main outputs 1-2.

14 Connect an external VU meter to each of the I/O
outputs in turn. (One at a time as you calibrate.)

15 Set all Pro Tools track faders to their default of
0 dB by Option-clicking (Mac) or Alt-clicking
(Windows) any fader.

16 Adjust the I/O output level trim pot with a
small, flat-head screwdriver to align the outputs
to read “0 VU” on the external VU meter. We
recommend using a tweaker tool with a re-
cessed flat-head surrounded by a plastic tube to
hold the trim pot. Tweakers can usually be
found at electronic supply stores.

To calibrate the HD 1/O inputs:

1 Connect the HD I/O outputs to a bank of
HD I/O inputs by doing either of the following:
» UseaDB-25to DB-25 straight through cable.

¢ Interconnect the XLR ends of DB-25-to-XLR
together.

2 InPro Tools, select Options > Calibration Mode.

The names of all uncalibrated tracks begin to flash.
In addition, the track volume indicator of each
Auxiliary Input track receiving an external input
signal now displays the reference level coming
from the calibrated output (default is —18 dB).

3 Adjust the HD I/O input level trim pots with the
same small flat-head screwdriver or tweaker. It
is best to calibrate the inputs with the back of
the HD 1/O facing you and the Pro Tools screen
well in sight. If you cannot see the Pro Tools
screen, consider asking another person to assist
you with the input calibration. When the level is
properly matched, the track name will stop
flashing and the peak volume indicator will in-
dicate your headroom value (the default is
“~18.0").

The Automatch indicator arrows on each track
show the direction of adjustment required for
alignment:

* When the incoming level is higher than the
reference level, the down arrow will appear
lit (blue). In this case, trim the I/O input level
down.

* When the incoming level is lower than the
reference level the up arrow will appear lit
(red). In this case, trim the I/O input level up.

When you have properly aligned the incoming

peak signal levels to match the calibration refer-
ence level, both Automatch indicator arrows will
light: the up arrow red and the down arrow blue.

Above the fader is a peak volume indicator. This
indicator will show the dB level above and below
your chosen headroom value. If the peak indicator
is showing —19.1, you are —1.1 dB below a head-
room value of —18 dB. If the display is showing
—16.5, you are +1.5 dB above your headroom value
of —18 dB.

4 When you have finished, deselect Options >
Calibration Mode.

Chapter 7: HD I/O Calibration Mode Instructions
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Switching Jumpers on the
Analog Output Card

Lo H
Each Analog Output card for HD I/O provides a e o e

jumper for each of the eight channels of output on
the card to switch between a Hi and Lo output set-
ting. The default setting for each jumper is Hi. This
is what you want for working with professional

gear that operates at +4 dBu levels. I

However, if you are working with —10 dBV gear, Pin orientation on Output card
you can switch the jumper on Analog Output card
(on a channel-by-channel basis) from the default
Hi position to Lo for a—6 dB pad. You can then ad-
just the Trim pot for the corresponding output
channels by an additional -4 dB to accommodate
—10 dBV gear.

5 Replace the Output card in the HD I/O chassis
(as described in Chapter 5, “Adding or Remov-
ing I/O Cards”).

To switch the jumpers for output channels on an

Output card:

1 Remove the Output card from the HD /O chas-
sis (as described in Chapter 5, “Adding or Re-
moving I/O Cards”).

2 Place the card on a stable, static free surface.

3 Using tweezers or a pair of needle nose pliers,
gently remove the jumper for each output chan-
nel that you want to modify.

4 Gently, but firmly, replace the jumper in the
position that you want for Hi or Lo output:
 Place the jumper so that it connects the mid-
dle pin and the back pin (furthest from the
DB-25 connector) for the Hi setting (this is
the factory default setting).

» Place the jumper so that it connects the mid-
dle pin and the front pin (closest to the DB-25
connector) for the Lo setting (—6 dB pad).
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F—TWEMERLTIIZEEN,

LOOP SYNC In/Out

Loop Sync i&. # 44D Pro Tools|HD F#=
BEDF—T 4 F - A2 =T 2 —XF
72i& SYNCHD & 1 DL EDF—F ¢ F -
AVE—=T 2—R) ZRAME RS 2DHDEH
D77« )b—TTF, Loop Sync Hiifiid.
Pro Tools & A7 LDALE D Pro Tools|HD
F =T F AR =T - RIHRKEN
o7 VR IVEERADOEIAZAIREIC LE T,
Loop Sync (&, 44.1kHz X 723 48kHz D
YINVL—rEbEicLieY—Rrav s
BEEzfVET, YATLOY YTV —
FRERBZE V=T e TEEDL—
MZfE> T44.1kHz X 7213 48kHz D L— b %2
LEICHELE T,

Loop Sync In R— T & Loop Sync Out K—
M. IxT—RKIay 7E8EHTT 5 HE
HEDBNC I3+ 2 —T9, Loop SyncF#
D Pro Tools|HD fds Z f&hid 5 & ED
AEHALES (Pro Tools]HD A —7 ¢ 4 -
A Y2 —7 x—ALSYNC HD Z##i 9 %
BB E),

ACEF
OaxT 2=, BEODACER T —7
WIHIE LU TWE T, HD 1/0 & B B EJE
R (100V ~240V) T, EODET & AZHE
DEY 25—+« r—7J) (IEC) %#fti>T
ACEFHa VLY b\ EHITEET,

oY Y= ¢ K—b
COR—MIHEBEEL TV EE A

%25 Pro Tools | HD I/0 O#Z&
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£ 3%Pro Tools | HD 1/0 Z#&i& 9 %

Pro Tools | HD I/O Ti&. Pro Tools | HDX.
Pro Tools | HD Native, Pro Tools|HD TfEHd %
BRK16F ¥ 2D 7Fa i BLUTI4
VIO ZHTEET,

HDXPro Tools|[ HDX /\— F™ = 77 Cl&. HD
1/0 i DigiLink Mini 77— 7 )L & ffi 5 T
HDX #1— RA#fi LE 9. HD I/O/\v ¥
IV DOILERAR— . HDX A — FD2DH
® DigiLink Mini Port. & 7ziZiE/md HDX
H—RZHHLUTCHDA =T 14122 —
Tr—AZHERTEELET, 60 X—TD
[Pro Tools | HD I/O 7% Pro Tools | HDX
H— RIS 5] ZIBHRSEE W,

HDX 71— RO A Y A b —ViZ DT,
HFLLWE THD A YA F =)V« A K]
ZTHBRILEE W0,

HD NativePro Tools | HD Native /x— K™/ =
77 Tld. HD 1/0 & DigiLink Mini 77— 7"V
% {fi 5 T HD Native /71— F\###t L £ 9, HD
[/0 73y 732V OHEEER— b, HD 1— R D
2D H ?D DigiLink Mini Port. X 7z{& HD
Native 77— R ®D 2 D& ? DigiLink Mini Port
ZEMUCHDA =T 4 A AV 2 —T = —
AZWHRTEET, 63 R—=ID
[Pro Tools | HD I/0 7% Pro Tools | HD
Native 77— RIC#E#id 5] ZTHMTEE
W,

HD Native 71— R DA ¥ A b —)Uic DL
T#FL <&, 'HD Native ¥ >~ A b —)L+
HARI Z2TBHLILEE 0,

Pro Tools|HDPro Tools|HD 2 A7 L Cld.
HD 1/0 {3 DigiLink Mini/DigiLink 77— 7"l
% i > T Pro Tools|HD 71— F\E&fi L £97,
HD OMNI D /3w 7 8 3 )V DR R — k%
72133B M D Pro Tools|HD 71— F &2 5 &
I/OJHD ¥ A7 LAHD 4 —F ¢ 4 « £~
R—T 1 —ARWMRITHILELETEET,
65 XN—® [Pro Tools | HD I/0 % Pro
Tools|HD 71— Ficf&#i § % | &2 TBM< 72
XU,

Pro Tools|HD 1— F DA Y A b —)LJ5
FEICDWTFEH L <, I'Pro Tools|HD
D—HP— A R ZTBRLITEE W,

HDA=F4F e A 59=T1—R%
SYIIIIPMTD

HDI1/O L AvidHD A —F ¢4 « 4 > X —
7 = — A, AMromfilicEs GEHED Ho
R E e UK T AMRDMIIZFNTZD |
WD 7 7 > 2B 0N LTIzb LT 72
WV, KEETF—RICTw I RLT
WABEEE, AMEDZIRICIEAT 1, JEAD
BERE G T AN D ETOT, VA
T LB T BT — A DEREZHLD
WLTLIEEW,

% 3% Pro Tools | HD /O =#&&%92 59



Pro Tools | HD 1/0 Z Pro Tools | HDX h— RIC#E#R 9IS

BHDXH—RIZ64F ¥ 2 NDF—FT 44 « AT v b7y hEEMHLET,
64F ¥ > 2IV10 % T IVITHE S ITiZ, 450D 16 F ¥ > % JUHD 1/0 % HDX 71— RICHEHi L
9, 2DDA VA —7 x— AFEHE Digilink Mini B— 1 & 21c#H L. ftho 2 D3k
#1D 2 DD HD 1/0 DILFRAR— McHEH L E T,

HD 1/0 %2 HDX h— RNz I BICIT :

« 8D DigiLink Mini—7 /L% {fi->T. HD 1/0 ® PRIMARY PORT % HDX 71— K ®
DigiLink Mini Port 1 "##&#t L %97,

1. HDX#A—R® DigiLink Mini Port 1[C##: L7z HD 1/0

HD 1/0 ZEhliEm T BICIS :
11B5HDA—F 44 - A2 —T 2 —A&HERK Uk, LFOWIT N ZiT-> TEMD HD
/0 (F72EMfSA—F 4 A « A2 —Tx2—R) BEHRLET,
« DigiLink Mini 7 — 7V ffi>o T 2BHD A Y X —T 2 —ADT 54V — - R—+ %
1BHDA >V RZ—T 2 — ADIER— bAEHELE T,
ER %

« 2BHDA Y A—T 2 —ADT T A<V — + K— h 7% HDX 71— F D DigiLink Mini R —
2R L £ 9,

2 FEDOFIEEEMDOHDX 71— RICH LT
BMOERLET,

3 %75 Loop Sync #Ei A 1TWVE T (61 X—T D [Loop Sync Z##Hid %1 BH).
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Loop Sync Zi&RJIS

2B EOHDA—F 44 « £ &2 —T 2 — AE 7213 SYNC R =i 4 585 &%, #%
#az iE U A& % 728 Loop Sync Z##i § 2 BN H D £97, HED Avid HD A —7F «
F oA VBR—T 12— AEHEHT BHIF 62 X—Y DN 2% THBIMLEE W, SYNCEEHT
BHNCOVTIE, TSYNCHD A+ RJ 2 B ZE 0,

Loop Sync Z&E#&i I BIci3 :

1BNCr—7 )V li> THEDA ¥ 2 —T7 2 —AD Loop Sync Out ZXDA > X — T 2 —AD
Loop Sync In ~\##i L £ 9,

2BNCr— 7))V fli> TRBED A > 2 —T 2 —ZADLoop SyncOut Z 1 5HD A > % —T = —
A 721 SYNC @ Loop Sync In \#&#i L £97,

% 3% Pro Tools | HD /O =92 61
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® 2. 2DOHDXA—R. 12D HD OMNI. 52D HD I/O £@ DigiLink &t & DIL—7 -

Pro Tools | HD 1/0 A4 K

E_HDXA—FK

~

P4

”

T

=+

L



5_%) Tools | HD 1/0 %Z Pro Tools | HD Native 57— RIc#&#

HD 1/0 %Z HD Native 1— RAERT BICIS

« (/8 DigiLink Mini 7 — 7 /L% {fi > T HD 1/0 ® PRIMARY PORT % HD Native 7 — K
DigiLink Mini Port 1 "##&#t L %97,

3. HD Native 71— R® DigiLink Mini Port 1 [C## L7zHD I/O

2D0DHD I/0%Z HD Native 1— FAERT HICII :

1 {8 D DigiLink Mini 77— 7 )L {#i> T, PRIMARY PORT % HD Native 77— F ® DigiLink
Mini Port 1 NE&#i L £ 9,

2L FOWT D ZEIT> TEMDHD 1/0 (£ 72iE 5 )i Pro Tools A — 7 4 &« 4 > 2 —
Tr—R) ZHRLET,
« 3B/ DigiLink Min (& 7ziZ DigiLink % DigiLink Mini 77 % 7" % —Ic) %Zffi->T2HHD
A % —"7 2 —ADPRIMARY PORT % 1 §H D+ > % —7 = — A EXPANSION PORT
ICHERELE T,
EzS
 2BHDA VA =T 2 —ADT T A<V — - R— k& HD Native 77— F ® DigiLink Mini
R—h 2 ERLET,
3 % E 7% Loop Sync i #1170 E T (64 X—T D TLoop Sync Z AT %1 B,

% 3% Pro Tools | HD /O =92 63



Loop Sync Zi&RJIS

2ELLEOHD A —FT 4 F « £ & —T7 2 — A 7213 SYNC MRS i 3 25513, B
ZIE U L A E & % 728 Loop Sync Z##i 9 2 45BN H D £9, SYNC Z S 5 4icD
WTIWE FTSYNCHD A R 1 ZTHBLIEEI WV, HEOAVIdHD A —FT 44 « 4 V& —
T — AT AHZ. K 4% TBBITEET WD,

Loop Sync Z&E#&i I BIci3 :

1BNCT— TN =fi> TEDA Y2 —T 2 —AD Loop Sync Out ZRDA 22 —T = —AD
Loop Sync In ~\##i L £ 9,

2BNC 7 —T7 )7 ffi> TRED A > Z—T £ —AD Loop Sync Out Z 1 B5HD A > &% —
7 2 — AE 721 SYNC D Loop Sync In i L X 7,

4. HD I/Os &HD 1/O @ DigiLink ##i& Loop Syncifi
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Pro Tools | HD 1/0 Z Pro Tools|HD h— RIC#E#R I3
HD 1/0 % Pro Tools|HD A— RICiEHRTBICIS :

= DigiLink 77— 7l (Pro Tools|HD > X7 LI ft)@) & DigiLink Mini 77 % 7" 2 —Z%fifi > T,
HD 1/0 @ PRIMARY PORT % Pro Tools|HD 71— FDZEW T % ] D DigiLink R— kA
HRiL£9,

DigiLink Mini ZERb {157z
12 7« —b®DDigiLink 7 —Z b

5. Pro Tools|HD Accel Core1— R®DDigiLink Port~&# L7zHD /0 (16 F + X ILDI/O Y AT L)
EHDHD /0% Pro Tools|HD YR F LANER I BICIE :

1 DigiLink Mini 7 & 7" % —IZH{ O {1) 7z DigiLink 77— 77V (Pro Tools|HD ¥ A7 LI {1 &)
*° DigiLink Z{i> T 1 &5 HDHD I/0 ® PRIMARY PORT % Pro Tools|HD Accel Core 71—
R @ DigiLink R— b L £97,
2 FOVT N DEMEZITNE T,
« {{JBD 18 > F DigiLink Mini ¥ —7 L% {i> T, 26HOHD /0D T T4 <V « F—
F21E5HDHD1/0 D [EXPANSION PORT] ~NE#Hi L £9,
EQrrS
« DigiLink Mini 7" % 7" % —ICHU D {11} 7z DigiLink 77— 7 )L (Pro Tools|HD & A 7 Ll
{#) % DigiLink Z > T. 2% H® HD I/0 ® PRIMARY PORT &KX D7V T 5
Pro Tools|HD /71— FA\EE#i L £9°,
3B/ HD 1/0 Z38/1nD Pro Tools|HD 7 — R\#E#E L £ 9,

4 Y E75 Loop Sync #6211 £9,

% 3E Pro Tools | HD 1/0 =9 %
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Loop Sync Zi&RJIS

2HBLLEDPro Tools A —F 4 4+ A > Z—7 = — A I3 EIWIHEES SYNC Z i 9 35551,
BaZ1E LU SRS % 728 Loop Sync ZH#i§ 2 080 H D 97, HED Avid HD 4 —
TAF e A E—=T 2 — AWk T H0lE. K6z TZI W,

Loop Sync Z&E#&i I BIci3 :

1BNCT— TN =fi>TEDA Y2 —T 2 —AD Loop Sync Out ZRDA 22 —T = —AD
Loop Sync In N LET (5714 Y —Fz—2),

2BNC 7 —T7 )7 ffi> TRED A > Z—T £ —AD Loop Sync Out Z 1 B5HD A > &% —
7 2 — AE 721 SYNC D Loop Sync In i L X 7,

ProTools|HD Accel Core
H—R

Pro Tools|HD Accel
H—R

6. 22D Pro Tools|HD 31— K. 12D HD OMNI.3D®HD I/0 £®D DigiLink##t& D Loop SynciZi
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£ 4= Pro Tools | HD Software T
Pro Tools | HD 1/O Z8&8E€ T3

T DOETIE. Pro Tools | HD 1/0 Z i FH
T % 728D Pro Tools DEE /12 L
9,

Pro Tools T D& & /71D W T lZ.
[Pro Tools V 77 LA « A K1 %
SR TZE W,

IN—=ROTT7ERE

IN=RT 2 7REIZATAT TR T 7+
WEDY YT L—bDRE (Evya v
MW TWEWGEE) .Y AT LDy 7 -
V—ADRE, FF—TFT 4 A+ A &—
TJr—ADOaY ra— )L —RXNEETE
E I

FIFILNDYTIVL—

(Y FILb—K] REICIZ. Filltzy e
VEAERT BEEDT I I EDOY T
WL —b"DRERENET rB.yva
YHBHWTWAIRETIE., CTOHHEERY
TTw TR a— UTERINETA),

4 > TV L— RIS T Pro Tools +

S vavEMERT S EEI HiMty
vav] X7 RS TEET ST LN
TEET,

HiREyYaYOFI+ WMDY YTV — M EE
EIHICE:

1 Pro Toolsz v a AW TWBEEZ.
Ty yarvEPHUET,

2 [£% &1 (Setup) > [/\— KD =771 (Hardware)
IR ET,

3[HYTIL—R] Ry T 79T « XZa—
MECHBOY TV — b EEIRLE T,

Peripherals
HD OMNI #1

HDX #1, Port 1 Exp
Clock Soure: marmal~)
Loop Master: HD OMNI #1

Sample Rate: m v 44.1 kHz
48 kHz h'
88.2 kHz

96 kHz
176.4 kHz
192 kHz

FIFIOY YTV — NERIRT D
4[0Kl 27 Vv L&Y,

%4F Pro Tools | HD Software T Pro Tools | HD /O Z&EY %
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AP YT I — k& Pro Tools| HD#REES X5 s

Y27 )L — 1 176.4kHz & 192kHz TEH
T&%ProToolsHD 1— Fld4DETTY,
ZTOfMDH—F (AT LORKAT— R
&7 BIEY VT 4T E—RIKEDET,
Pro Tools|HD 71— K & Z D 71— R i
INFHEERIZ V> T IV L— A 96kHZ LU R
ICREESND EMUT T4 7D RS
L <1& TPro Tools sk A7 Ly« 7T A K |
2.

A 5L EDPro Tools|HD /1 — R &2 £§D
iR AT L2, 96kHz Zi8 2 58 > 7
VL= THEMATZ7HICE. 5DHLL
%0 Pro Tools|HD /1 — R S 17z
OZEONSHTNE R FH A

20vY9 « V=R

Pro Tools ®/v— K7 = 7 #%5E (Hardware
Setup) XA 7T TIZ .Y ATLDOIOYT-
V—ADNRETEET,

425 =% (Internal)Pro Tools TV F 11
JESEFEELI—T 2 V7T BEEE.
B, Pro Tools DAYEF—F)b 7w 7 »
V—A %R LU £,

SHER (ExternaD ¥} 58D 7 2 Z L EE s 5
Pro Tools \T— X %E%(% &, Hlzld—
REENT 2« vy ZEEBRMHT S L
&, Pro Tools ZH PSR ICRIBI T B £ 9,
F—TF K e AV RA—T 2 — ADKEIK &3
WLUEEY YTV L—hick->T, LRDOF
TrarvhbbET,

e S/PDIF [Encl] (T XTDOY T

L—hk)
« Optical (S/PDIF) [Encl] (%K 96kHz)

« AES/EBU [Encll (§ XToDY T )L
L—h)

68 Pro Tools | HD /O A K

o AES/EBU 1-8 (3 RXTDY )L L —
FDODRATF LA - RT7DT TV TA
—)

« AES/EBU 1-4 (Dual Wire) (176.4kHz
E192kHZICBWTAT LA - X7 T)

o ADAT 1-8 (44.1kH & 48kHz)

o ADAT S/MUX 1-4(88.2kHz & 96kHz)

o ADAT S/MUX1-2(176.4kHz & 192kHz)

« TDIF 1-8 (44.1kH & 48kHz)

« Optical ADAT Encl] (44.1kH & 48kHz)

o Word Clock(3RXTOHF 7 I)IVL—1k)

o0y « Y=RAEEIRTBICE :

1 [87%] (Setup) > [/\— RD £ 77] (Hardware)
Ve i/ N U= S

2[r0wv% v—2] (Clock Source) R 7
Ty TR a—ho@EYEsay s - —
AEERLUE T,

Peripherals Interface: HD I/0
HD OMNI #1 Main

Input
1-2 | Analog 1-2 v
3-4 | Analog 3-4

HDX #1, Port 1 Exp HD OMNI #1 » | Analog 5-6

Clock Source: #1 > Internal N

AES/EBU [Encl] "

Loop Master: HD 1/O #1 9-10
Optical (ADAT) [Encl]

e T R
11-12

Word Clock (44.1kHz)

o0vY - V-REERTD
3[0Kl Z#27 Vv L&Y,

A\ Pro Tools 7 7 Z )URBRIC I X ¥ %
I, AR S N TE D BESAS
TRIREETH A NENDH D X9, A1
WKEFENPAS TOWAEWVES, 7av s -
V=AW [AE] K LTHEET,



o]

VAT LNEBOF CHEBOA—T 1 4 -
AV A =T 2 —AZER LTV IHEE.
KAV R—T 2 —AZ#HHTHENTE
9., TNCE>T, [h—F7x7RE]
(Hardware Setup) X717 TAJ1&H
N72aiE 3 B E%. AR ] (Peripherals)
VDARNBELWA V2 —T 12— A%ER
TEET,

VATLDF=F 4 F AV =Tx—RA&HHTS
ITI :

1 [2%E] (Setup) > [/\— KD =71 (Hardware)
BN 9,

2 [ #2581 (Peripherals) V A 5,
VAT LR EN TV A A —T oA AV
2—T r—AZERL LT,

EFORAF—ZM>T IN—FYx7
#E] (Hardware Setup) %4 7711270
[V 7 = F)V] (Peripherals) U X + %
A7 —)IVLET,

3IN—FRUL7HE] BAT7TDETIC
b2 [HRITS] (Identify) + 7 a vizi#
WLET, BIRLIEA—T o4 - A X—
Tr—AD710Y rI)SRJ)VDOLEDWNE AT
HITLUET,
4BRNUIEA SV ER—T 2 —ANAZIFD
EDAVE—T 22— AW L TN S A
ELTLEE W,

58 A —F 4F AR —T 2 —RICHL
TEHEOTFIEEHEDERLET,

554 % Pro Tools | HD Software T Pro Tools | HD I/0Z®&E9 2% 69

HD 1/0 ZE5&ET D
HD /O DY FO— L ERET BICIS :

1 [8%E] (Setup) > /\—R2x 771 (Hardware)
ZEIRLXJ,

2 [JEJB§AR] (Peripherals) YV A k¢, HD 1/0
F—T 4 XA E—T 21— AZEIRLE T,

3[X4A4>]1 (Main) 27 %270y oL, &7
varvERELET (BR),

Hardware Setup

HD /O DI\—RI I 7EE. [XAV] R=Y

AHDI/OAD hH— Kbl s 1H65b%
B&. [7709 421 (Analog In) 27 %2
Vw7 UL, A7y a kxR ELEST, HD
[/OADH—FMW2EBH 255G, TOXTIX
(7709 421-8] LERENKT,

Hardware Setup
02 T Digial
Reference Level Limiter

1 @ +4dsu O -10 None ]
2 O -10 None ]
3 @+ O -10 None ]
4 @+ O -10 None ]
5 @+ O -10 None ]
6 @ +a O -10 None ]
7 @+ O -10 None ]
8 @+ O -10 None ]

idemy (SIS

HD /O DN\—RI T 7RE. [7F3OT 4 VIR—=I



5HD I/0 AD 1— R 265H 556, [7F
0 14> 9-16] 27722 Vv 7L, 2EC
JGUTAT Vg v eRELE T,

Hardware Setup

Peripherals
HD IO #1

&

2222 2229,
P00 POO®®
Segedin s

O dentiy o

HD /O D/\— R T P&, [7F05 A~ 9-16]
N—y

6V EE1DDODHDI/OTY X)L« J1—
FEfALTVW HAE. [FIFIL]
(Digital) #7 2DDOHD /O T Z )b »
H—FWNA VA= IVENTWVBRHEI
[7Y%)L1-8] (Digital 1-8)) =27 Vv 7 L
THHDA T a VERELET.

Hardware Setup

Peripherals
HD OMNI #1

> HD IO #1

Oa
QOa

ety (SerTo pefau )

(GRS

HD /O DIN\—RDz7HRE. [TIFI] XR—T

O 48kHz & # 2 39~ TV L — kT,
T OSIMUX AT T 4 IV LTV B
HZE. HDI/JO TV X - 1— KD
TDIEA > 7 k&4 77« 71)L (ADAT)
DEODFTXRTCDA YTy hDY T
L— MEBEAPHEICA IR T,
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72DO0OHD /0T V&) - H—REMAL
TV 3 HE1R. [FY%IU9-16] (Digital
9-16) 27 %227V w7 LTCHWNDF T g
VEHBRELET,

8bolzh, [OKl 227w 7 LET,

ﬂDHOO[A—FUITEE]wt
3y
HDI/OD N—RI 2 7&E] OF T3
NCiE. FORERICE > THEHEOR—IN
HHEI,

R o RN=Y

HD I/0 k. #EDI/0 7 +—<v k (7F
a7, AES/EBU. ADAT A 75 « h1 b,
S/MUX. S/PDIF. TDIF) THK16F v >~
IINDAY Ty FEeET TRy MTHIGL
Tll\ia‘o

N— K7 = 7i%E (Hardware Setup) %1
7arg DALY (Main) XR—=Y Tl&, 4 —
T4 F e A VER—=T 2 —ARKDED AT
& Wi 717% Pro Tools D A J1 & HFi~\ )L —
TAYTTBENERELET, TOXAT
07X, ProTools A —F 14 « 42 &—
71— AKREKD A S & 7% Pro Tools D =
FY—DF vV RIVICTIAL VT B8 F
RAEEEZEZNEIOVTLX I,

Hardware Setup

Peripherals
HD IO #1
>HD 110 #2

Ext. Clock Output: (Word Clock (96 kiz) +

HD OMNI &HD I/0 hi&Rm&ENTz /O RE] 51
rOoso [l R—Y (8 x 8 x 8ZRT)

|
[T
-2 (Analog 1-2 &
-4 (Analog 3-4 &
-6 (Analog 5-6 &
5 (Analog 7-8 &
16 (As/eau7-s  18)
SetTo Defaulc

(] identify




A7 (Input)

AT RDRY T Ty T A a—"5,
Pro Tools DA > T b +F v 2 X)L DFK A
T LA - X7 (1-2, 3-4, ..15-16) <X}
ST AW A Y Ty b e RTREINL 9,
EDYEA Y Ty "HIMERTES IRV
AR—=ILENTWSHD /ORI — R &
PN — &> THREDET (E
ZE. HDI/OAD i— R AV A +—IL &
ncnEThEyras «- 227y Ml
HTEEEA),

ﬁy:mg®§iu\hvv3yw?u&<\
L VAT LRBEENET,

i3 (Output)

TIORTY RORY T Ty TR a—n5,
Pro Tools D77 F 7w b « F% )LD
BAT LA - RT (1-2. 3-4. ...15-16)
KRGS M7 RS k- X7 B EER
LET, EOYHETT N Ty "BEHTE
B A VAR —)LENTWAHD /0 ¥k
BH—REI I L —hMk>THEAED
9 (feLz21E. HD1/O DA J1— KRB A1 >
Ar—=ENTWiEE7ras -7k
Ty FIFEATEEEA). TNSDREIR.
twg TR EL, VAT LICREFEE
hi@‘o

HROA YTy RRT7 Y R Ty k2%
9 % & Z&. Control- 7V v 7 (Mac)
F7zid Start- 7V v 7 (Windows) LT
{REV, IRTOA YTy FETIET
U hTYy NOREENAT—RT 3L
& &, Command-Option- 7 V v 7 (Mac)
% 721X Control-Alt- 7 U »» 7 (Windows)
LTLZEW,

854 % Pro Tools | HD Software T Pro Tools | HD I/0Z&Edg 2 71

BUI#—~Nv hDAV Ty hEFDIRTyY b

HUES5&T+—<v FOAHMIIEZ. AN
EHITOF v IRy T 7w TR
Za—DOHRTRPIENTVET, & 2,
HDI/O KD AES/EBU DA > T b &7
7 k7w Mi& [AES/EBU [Encl] 1 & &R
TN HD /O 7Y &)U+ F— KD AES/EBU
DAY Ty b7 ~7w ME [AES/EBU
1-21. [AES/EBU 3-4]. [AES/EBU 5-61.
[AES/EBU 7-8] &RV TERINET,
2DODFIRIV - H1— R EFHEDHD /0 Tli.
B fnd AES/EBU 1/0 :K— b (& [AES/EBU
9-101 . [AES/EBU 11-12] . [AES/EBU
13—141. [AES/EBU 15-16] £ & RENE T,

FIFIN e TF=Iv b

W7 2V & % & XX, LUF
DFIRZIV e ATy ke Tr—<vw &
EINL T L 72w GEhndHD 1/0 Digital
H—ROA TV g Vi, FNFhoi—RIC
N B [FIUPIW] 2T 7270w 7 LTk
EFELTLIEEW),

AES/EBU. & K2 5 v > % )LD AES/EBU
AT b,

SIPDIF2 F ¥ > )LD S/PDIF (i) >
A

Optical(S/PDIF)2 7 ¥ > )L O S/PDIF
([FAlflh) 4> 7y b, K 96kHzo TDA T
v a3 96kHz K b @ T )V L— KT
LBIRTEE A,

S/IPDIF7#x—<v b

Tascam DA-30 DAT L a— & — & H koD
% % S/PDIF (Sony/Phillips Digital
Interface Format) TiZ. [S/PDIF 7 % —
< ] OTFOD [Tascam] 4 7> g > 7%
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Output) R 77w T A= a—h 5]k
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176.4kHz J—RoOwo | 9—R
(176.4kHz) 0wy
(44.1kH2)
192kHz J—RoOwvo | O9—R
(192kH2) 0wy
48kHz
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FIGNW e TFx=IY b

HD 1/0 7Y &I H—RDFI R+
TA—<v hNeERLET, YTV —
MCEo>TTFYVEIL s TH—< v O
vaYidBEEDET,

Peripherals

HD OMNI #1 Interface HD1/0
>HD /0 #1

AHD MADI DigiLink 1

Digital Format: Sample Rate Conversion:

@ AES/EBU 1-8 Ochi-2

() ADAT 1-8 [Jch3-4

HD Core PCle #1, Exp O ToF1-8 Cchs-s
Clock Source Cchr-s

[ internal B
Loop Master: HD OMN1 #1

Sample Rate

(441 khz =)

HDI/ODU\— RO 7REI Y1 705.44.1kHz
TO [FIFI TH—Xv N T3y

Peripherals
HD OMNI 1 Interface HD 10
> HD 10 #1 7
AHD MADI DigiLink 1
Digital Format: sample Rate C
AES/EBU Ochiz
® AEs/EBU 1-8 Och3-a
HD Core PCle 41, Exp ADAT Olchisse
Clock Source: o) QOch7-8
(Cinternal )] Oz Snan)
Loop Master: HD OMNI #1 e
0 1-8 RO
sample Rate:
| 96 kHz. %)

HD I/O® [\—RDI T 7:EE]. 96kHzTD
[(ZIUFIT+— v b FTv3av

Peripherals
HD OMNI #1 Interface: HD /O
> HD 10 #1

AHD MADI DigiLink 1

Digital Format: Sample Rate Conversion:

AES/EBU Cechi-z

@ 1-8 (single Wire) O chs-a
HD Core PCle #1, Exp O 1-4 (Dual wire) e
Clock Source ADAT; Ochz-sg
[ internal 2 Onseae
Loop Master: HD OMNI #1 =2l
ToIF
sample Rate: O

| 192 kHz %)

HD I/IO® U\—RDx7:&E]. 192kHzTD
[(FIFIN T3— v N T3y
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AES/EBU

TN —REk>T, BAR8F ¥ %
JVD AES/EBU A > 7y v HEIRTEE T,
Y7L — b 44.1kHz » 5 96kHz T3,
BINTESHF T 9203 [AES/EBU 1-81
(£ 22HDH— KWL A R—ILER
TV 3551 [AES/EBU 9-161) 7213 T9,
7L — b 176.4kHz & 196kHz TlZ.
2DDAES/EBUA T gy () -TIA4
Y= TFa I TA V=) PEINTEET,

AES/EBU 1-8AES/EBU 1 > 7w h &8 F ¥
VHIVEHT A HEAE. coF Ty g vk
BINLET, TOLFT¥a vid, 7
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9, cOLFTvavi, chkbEnt
VTNV — R TREBRTEEREA,
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AES/EBUA Ty " 8F v ¥/ X JUEH T
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UGN T A — c BE—REEIR L2 &
XX, BATFLA XTI LTH T IV
L—"EWMMPTAET, COXT Vg Vid,
YTV L — b 176.4kHz & 196kHz TD H
LRENET,

AES/EBU 1-4 (a7l --94v=) b7
JUL— b 176.4kHz & 196kHz T AES/EBU 1 >/
Ty NedF v xIVERT AR5 2O
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Y—+ E— KT, 7L — FEHIIZ
FR2ERA,. TOF T avix, o7
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ADAT

PN L—RMC &Ko T, mA8F ¥ 2 HILD
ADAT A > 7w FHEINTEET, 7
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%% 7 g% [ADAT 1-81 (F/zid22H
DH—=RWA VAR =ILENTWHBEER
[ADAT 9-161) 723 T3, > ILL—Fh
88.2kHz L FTld. 2 DD ADATH > g v
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HHIT25EE. COF T g U EBIRL
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Tra v, 96kHz K@Y IV L —
FTIHBIRTEEE A,
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1-4 (S/MUX) S/MUX (Sample Multiplexing)
ZRWIZADAT A > 7w e d4F v 2 2l
T 2%,EE. T4 T g v EEIRL
¥9, oL Tvavik, 7L —F
88.2kHz £ 96kHz TOAEXREINE T,

1-2 (S/MUX) S/MUX (Sample Multiplexing)
ZRWIZADAT A > 7w R E2F v 2 2l
T 2%HEE. T4 T g VEEIRL
¥9, oL Tvavik, v 7IL—F
176.4kHz & 196kHz TOHERENE T,

TDIF

YTV L—hT&oT, 8F v RILD
TDIF (Tascam Digital Input Format) -7 >/
Ty b QOHOA—FHA VA=)V E
NTW555&, [TDIF 1-8]1 £72& [TDIF
9-161) MFERTE LT, HIY > T )L L—
254 (SRC) Z1T5 M E I MIFEINTE
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7ZTDIFA > 7y w2 8F v IV %45
GlE. TOF Ty g URBEBRLEST, TOF
T g NF. Y7V L— b 88.2kHz & 48kHz
TORFRTEET,



S — MNER

HU 7 —bZE#E (SRC) &, AES/EBU
DATF LA « 42T w b« XTIHLT,
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£, ATy McHT BT IV L—1
UL, 7Y ZVI0H— R TORTAET,
ARAEWNED T T Z )V« R— N TIIITA FE Ao

A TV TR Ty MR YT IV L—
FEHUTIE RIS L TV EE A

A VTV — hEEE ANESICLA
TUY—ZMAET DT, BREDIZWVEG
BRATICLTHBINETT,

O 48kHz 2 %2 % ¥ > 7L L— kTl

" ADAT S/MUX A 75 1 AV 7§ L C
W55 a2k E, Digital /0 1— F D
TDIF A > 7 v b &A T F 14 h )b
(ADAT) D8 DODITXRTDAYT v b
OY VT L — NEHEH BT >
Ik £9,
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AES/EBU

FIZI-T#+—<w NNz AES/EBUICT % &
YT INL— b 44.1kHzh 5 96kHz £ T &
U e T A Y — T— KD 176.4kHz &
192kHz C. SRCIEFZEAT LA« A>T b -
RV LTAYERRZEATICTELT,
YTV L= BB, TaTINTA
Y—+T— KD 176.4kHz & 192kHz Ti1T
ZER A,

Peripherals
THDOMNIE ] |Imerface HD I/0
>HD YO #1
AHD MADI DigiLink 1

Digital Format: Sample Rate Conversion
AES/EBU ®ch1-z
© AES/EBU 1-8 & ch3-4
HD Core PCle #1, Exp ADAT = o
O 1-86RO B oot
O 1-4(5/Mux)
TOIF
O 1-8 6RO

BT —~96kHZ TAES/EBU A>T w b -
Fr oI 1-2BKU 34 ICHWESRC

ADAT

B>V L—k 44.1kHz & 48kHz Tl 7Y
DI T+—Xv 2 ADATICT B &, Y
TN L— R BT RTOF ¥ > Vi
LTCAVEREZATICTEET,
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48kHz K D mWH )V L— F T, FY
S T+—<w ;2 ADAT (SRC) 1T 5% &,
FARTOF v r2VlcH LTIV —
rEANABNICE IR D £9,



ADAT (S/MUX)

48kHz Kb VT 7TV — TR, TV
ZI - T+—<w ~2 ADAT (S/MUX) €9
L, IXRTOF vl LTH YT
WL— "W Fd XT3 FTICTEXT,

TDIF
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FENTWVETD,

RERERE B, Sy R T v T R—
DHEER EZET, FNTNOKIDOILEE
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$$6E DB-25J%I99—-DEVY7I b

7+O0% . “ °
9-79+IvEDB-25  7FOJ ATy k (+4dBu)

cHlwoT 24 CH1_HoT |24
1 cHlcowp |12 1 cHl_coLp |12
CH1_GND |25 CH1_GND |25
CHz_roT |10 cHz_roT |10
2 cH2_coLp |23 2 cH2_coLp |23
cH2_oNp [ 1L cH2_eNp |11
cH3_not |21 cn3_nor |21
3 cH3_cop |2 3 cH3_cop |2
CH3_GND |22 CH3_GND |22
Cha_HoT |-L CH4_HoT |-
4 | cua_corp |20 4 | cHa_cop [-20
cH4_GND |8 CH4_GND |-
CH5_HoT |18 CH5_HoT |18
5 | cus_cowp |-© 5 | cus_cowp [-6
CH5_GND |19 CH5_GND |19
CHe_HoT -4 CH6_HOT -4
6 cH6_coLp | 17 6 cH6_coLp |17
CH6_GND |- CH6_GND |2
CH7_HOT 15 CH7_HOT 15
7 | cw7_cown |3 7 | cw7_cown |3
CH7_GND |16 CH7_GND |16
CH8_HOT |1 cHg_HoT |1
8 cH8_coLp |14 8 cH8_coLp |14
CHB_GND |2 CHB_GND |2

NC1 13 g (el S
w1 | 26 MH1 | 26
MH2 |27 MH2 |27

mr /7L7
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gg_gg 427y b (-10dBV)

CcH1_HoT |24
1 | cHicowp |22
CH1_GND |23
cHz_not |10
2 cH2_coLp |23
cH2_GND |11
cn3_not |21
3 | cu3_cown |2
CH3_GND |22
Cha_HoT |-Z
4 cH4_coLp |20
CH4_GND |-
cHs_wor |18 |
5 | cus_cowp |-6
CH5_GND |12
CH6_HOT |-+
6 | cHe_cop |17
CH6_GND |2
CH7_HoT |12
7 |c7cop |3 |
CH7_GND | 16
CHB_HOT |-L
8 | cHs_cop [ 14
CHB_GND |2
N LB m
mH1 |26
w2 27 ¢
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AES/EBU DB-25

CH12_RCV_HOT
CH12_RCV_COLD
CH12_RCV_GND

24
12
25

CH34_RCV_HOT
CH34_RCV_COLD
CH34_RCV_GND

10

23

11

CH56_RCV_HOT
CH56_RCV_COLD
CH56_RCV_GND

21

22

CH78_RCV_HOT
CH78_RCV_COLD
CH78_RCV_GND

20

CH12_XMT_HOT
CH12_XMT_COLD
CH12_XMT_GND

18

19

CH34_XMT_HOT
CH34_XMT_COLD
CH34_XMT_GND

17

XMT

CH56_XMT_HOT
CH56_XMT_COLD
CH56_XMT_GND

15

16

7-8
XMT

CH78_XMT_HOT
CH78_XMT_COLD
CH78_XMT_GND

14

NC_1
MH1
MH2

13
26

27




TDIF DB-25

CHIZ_RCV_DATA |13
< 1-2 GNDL |23
= 3-4 CH34_RCV_DATA |12
g - GNp2 |24
5_6 CH56_RCV_DATA |11
3 - Gnp3 |23
x 7-8 CH78_RCV_DATA |10
- GND4 iz
CH12_XMT_DATA
< 1-2 GNDS ;4
= CH34_XMT_DATA
g 3-4 GND6 ;5
CH56_XMT_DATA
= 5-6 oNp7 |16
X 7-8 CH78_XMT_DATA |4
- GND8 |17
RCV_LRCK |2
RCV RCV_EMPHASIS L-Nc=
CLK+CTRL RCV_Fsl -8 mnc-
RCV_FSO 29 mNnc=
XMT_LRCK |2
XMT XMT_EMPHASTS | 18
CLK+CTRL xom_Fs1 |19 |
XMT_FS0 |-©
GND9 |7
mH1 [ 26
mH2 |27

DB25F_RA_TDIF

GND_C

FB30 FB31
T T
22PF 22pPF

GND_C Gyp_a  GND_C Gnp_a
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Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users
in the European Union

This symbol on the product or its packaging indicates that this
product must not be disposed of with other waste. Instead, it
is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling
of waste electrical and electronic equipment. The separate
collection and recycling of your waste equipment at the time of
disposal will help conserve natural resources and ensure that
it is recycled in a manner that protects human health and the
environment. For more information about where you can drop
off your waste equipment for recycling, please contact your
local city recycling office or the dealer from whom you purchased
the product.

Proposition 65 Warning

A This product contains chemicals, including lead,
known to the State of California to cause cancer
and birth defects or other reproductive harm.
Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of
California requires the following disclosure statement: “Perchlorate
Material — special handling may apply, See
www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

4y
e
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EMC (Electromagnetic
Compliance)

Avid declares that this product complies with the following standards
regulating emissions and immunity:

* FCC Part 15 Class A

+ EN55103-1 E4

+ EN55103-2 E4

* AS/NZS CISPR 22 Class A

+ CISPR 22 Class A

FCC Compliance for United States

Communication Statement

Note: This equipment has been tested and found to comply with
the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment
is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Any modifications to the unit, unless expressly approved by Avid,

could void the user's authority to operate the equipment.

Argentina Conformity

JAN

TV
Rheinland
Argentina 5.4
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Australia and New Zealand EMC
Regulations

€% wniToD

Canadian Compliance

This Class A digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les
exigences du Reglement sur le material brouilleur du Canada.

European Union Declaration of
Conformity

(EMC and Safety)

C€.

Avid is authorized to apply the CE (Conformité Europénne) mark
on this compliant equipment thereby declaring conformity to EMC
Directive 2004/108/EC and Low Voltage Directive 2006/95/EC.

Korean EMC Regulations

o A7) Q¥4 (A7) AAFA YA 12 B
WA EE AL AL o] A& F3A17) vet
#, Ag s AHolA ALg e Ag BA o
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Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian
safety certification in accordance with the specifications of UL
Standards: UL60065 7th /IEC 60065 7th and Canadian CAN/CSA
C22.2 60065:03. Avid Inc., has been authorized to apply the
appropriate UL & CUL mark on its compliant equipment.

Warning

RISK OF ELECTRIC SHOCK
DO NOT OPEN

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.
6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance
with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat
registers, stoves, or other equipment (including amplifiers) that
produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-
type plug. A polarized plug has two blades with one wider than the
other. A grounding type plug has two blades and a third grounding
prong. The wide blade or the third prong are provided for your
safety. If the provided plug does not fit into your outlet, consult
an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched
particularly at plugs, convenience receptacles, and the point
where they exit from the equipment.

11) Only use attachments/accessories specified by the
manufacturer.

12) For products that are not rack-mountable: Use only with a cart,
stand, tripod, bracket, or table specified by the manufacturer,
or sold with the equipment. When a cart is used, use caution when
moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused
for long periods of time.

14) Refer all servicing to qualified service personnel. Servicing
is required when the equipment has been damaged in any way,
such as power-supply cord or plug is damaged, liquid has been
spilled or objects have fallen into the equipment, the equipment
has been exposed to rain or moisture, does not operate normally,
or has been dropped.

15) For products that are a Mains powered device:

The equipment shall not be exposed to dripping or splashing
and no objects filled with liquids (such as vases) shall be placed
on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose
this equipment to rain or moisture.

16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type.

17) For products with a power switch:
The main power switch is located on the front panel of the HD I/O.
It should remain accessible after installation.

18) The equipment shall be used at a maximum ambient
temperature of 40° C.
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